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Preface
Welcome to the Genesys Interactive Insights 8.1 Deployment Guide. This 
document introduces you to the configuration, installation, setup, and start 
procedures that are relevant to the setup of Genesys Interactive Insights (GI2) 
universes and the operation of GI2 reports. 

This document is valid only for the 8.1.x releases of the GI2 product. 

This preface contains the following sections:
 About GI2, page 7
 Intended Audience, page 8
 Chapter Summaries, page 8
 Making Comments on This Document, page 9
 Contacting Genesys Customer Care, page 9
 Document Change History, page 9 

For information about related resources and about the conventions that are 
used in this document, see the supplementary material starting on page 111.

About GI2
GI2 provides reports that summarize contact center activity and an entire 
universe, named GI2_Universe, of elements that support them. 

Note: For versions of this document that have been created for other releases 
of these products, visit the Genesys Customer Care website, or request 
the Documentation Library DVD, which you can order by e-mail from 
Genesys Order Management at orderman@genesys.com.

mailto:orderman@genesys.com
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Intended Audience
This document, which is intended primarily for system administrators, assumes 
that you have a basic understanding of:

• Computer-telephony integration (CTI) concepts, processes, terminology, 
and applications. 

• Network design and operation. 

• Your own network configurations. 

• Contact-center functions and operations. 

• The Genesys telephony and interaction models. 

• The structure of and connectivity parameters for the Genesys Info Mart 
database. 

You should be familiar also with the installation, configuration, and use of SAP 
BusinessObjects Business Intelligence Platform (BI) 4.1 software, which is the 
third-party tool from which the GI2 reports and universe were built.

Chapter Summaries
In addition to this preface, this document contains the following chapters:

• Chapter 1, “Genesys Interactive Insights Overview”, beginning on 
page 13, sketches the interrelationships between the Genesys and 
BusinessObjects Enterprise (BO) components on which GI2 relies.

• Chapter 2, “Which BO Components Must Be Installed?”, beginning on 
page 19, describes the minimum subset of BO components that are needed 
for GI2 operation. 

• Chapter 4, “Installing Genesys Interactive Insights”, beginning on page 63, 
lists the prerequisites for installation and describes the steps to deploy GI2 
on UNIX and Microsoft Windows platforms. 

• Chapter 3, “Setting Up the Environment”, beginning on page 29, points out 
the additional setup steps that are required to ready your environment 
including linking the universe to Data Mart, setting data access restrictions, 
using GI2 in different languages, and customizing measure definitions. 

• Chapter 5, “Accessing Genesys Interactive Insights Components”, 
beginning on page 83, describes how to invoke certain BO applications in 
order to access the GI2 reports and universe. This chapter also provides 
specific references to BO documentation that describes how to use the 
applications. 

• Chapter 6, “Migrating Genesys Interactive Insights”, beginning on 
page 89, discusses how to organize your environment to maintain multiple 
universes of GI2 and how to link your custom reports to the most recent 
universe. 
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• Chapter 7, “Uninstalling Genesys Interactive Insights”, beginning on 
page 103, describes both the wizard-driven and manual steps that are 
required to uninstall GI2. 

Making Comments on This Document
If you especially like or dislike anything about this document, feel free to 
e-mail your comments to Techpubs.webadmin@genesys.com. 

You can comment on what you regard as specific errors or omissions, and on 
the accuracy, organization, subject matter, or completeness of this document. 
Please limit your comments to the scope of this document only and to the way 
in which the information is presented. Contact your Genesys Account 
Representative or Genesys Customer Care if you have suggestions about the 
product itself.

When you send us comments, you grant Genesys a nonexclusive right to use or 
distribute your comments in any way it believes appropriate, without incurring 
any obligation to you.

Contacting Genesys Customer Care
If you have purchased support directly from Genesys, please contact Genesys 
Customer Care. Before contacting Customer Care, please refer to the Genesys 
Care Support Guide for On-Premises for complete contact information and 
procedures. 

Document Change History
This section describes the changes that have been incorporated within this 
guide since the 8.1.0 release of GI2: 

Changes Introduced in Release 8.1.400

• SQL Server 2012 and Oracle 12 are supported (page 15). Support for 
Oracle 10g and 10g RAC is discontinued, effective February, 2014.

• New Data Access Restriction capabilities are added, including the ability 
to restrict access to objects within BO so that users see a limited set of data 
and reports. See page 56.

• Queue attached data is now supported: Queue hierarchies now provide key 
columns that you can configure to join to two custom user data Info Mart 
dimension tables of your choice. 

mailto:techpubs.webadmin@genesys.com
http://www.genesys.com/customer-care
http://www.genesys.com/customer-care
http://www.genesys.com/customer-care/support-processes
http://www.genesys.com/customer-care/support-processes
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• Updated the procedure “Translating the Universe, GI2 Reports, and BO 
GUI” on page 59.

Changes Introduced in Release 8.1.300

• A new prerequisite is identified on page 21 regarding BO installation in 
environments that use Security Enhanced RedHat Enterprise Linux. 

• The limitations for host-name specification are updated to match that 
documented by SAP BusinessObjects. See pages 66 (CMS host) and 69 
(CMS host and SIA node name). 

• The steps required to apply, or re-apply, BO customization are updated. 
See page 31.

• A note was added on page 33 to warn against using the Genesys-provided 
GI2_GIM_DB connection. This connection is reserved for Genesys use only.

• A note is added on page 35 that provides driver type recommendations for 
configuring a Universe connection with Microsoft SQL Server. 

• The listing of RAA releases that correspond to GI2 releases has been added 
to Table 3 in the “Interoperability of Software Components” section. See 
page 90.

• Information added describing the migration of the custom universe and 
reports in Release 8.1.3. See page 93.

• Among the files that the GI2 installation routine deploys are new scripts 
and directories that support a BI 4.1 deployment. Refer to “Application 
Files” beginning on page 107 for the complete listing and descriptions of 
the deployed files. 

• Additional changes were made throughout this document to introduce BI 
4.1 as the supporting suite for GI2 8.1.3 operation. 

• Added procedures describing the steps required to create a Connection to 
your data source in BI 4.1 deployments. See “Defining a New Connection 
(BI 4.1)” on page 37 or “Using the Default Connection (BI 4.1)” on 
page 39, and “Connecting to the GI2 Universe (BI 4.1)” on page 41.

Changes Introduced in Release 8.1.104

• New Data Access Restriction capabilities are added, including the ability 
to restrict access to objects within BO so that users see a limited set of data 
and reports. See page 56. 

• Queue attached data is now supported: Queue hierarchies now provide key 
columns that you can configure to join to two custom user data Info Mart 
dimension tables of your choice. 

• SQL Server 2012 and Oracle 12 are supported (page 15). Support for 
Oracle 10g and 10g RAC is discontinued, effective February, 2014.
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Changes Introduced in Release 8.1.101

• “Setting Up Attached Data” on page 32 is a new addition to this document. 

• The last step that was previously listed in the “Creating Connection 
Restrictions” section was moved to Step 10 (page 36) of the “Defining a 
New Connection” section. 

• The previous instruction to “Export the results back to CMS” on page 60 
was updated to “Save and export the results back to CMS”. 

• A sixth step was added to the procedure for setting up your system to use 
the GI2 universe and display GI2 reports in a different language when you 
change your host’s default locale. See page 61. 

• A new section, “Accessing Translation Manager” on page 87 was added. 

• The script folder was removed from Table 4 beginning on page 107. The 
GI2 installation routine was corrected to deploy this folder as a subfolder 
of the agg folder. 

Changes Introduced in Release 8.1.100

• Instructions were added for using GI2 in different languages. See page 59. 

Changes Introduced in Release 8.1.000

• Several third-party drivers and some customization scripts were added to 
the Reporting and Analytics Aggregates installation package, which is 
included within the GI2 installation package. Refer to the Reporting and 
Analytics Aggregates 8.1 Deployment Guide for a listing of these drivers 
and descriptions of these scripts. 

Other Changes

For information about changes to reports and the universe elements that were 
introduced throughout the 8.1 releases, refer to the Genesys Interactive 
Insights 8.1 Universe Guide. Also, refer to the Genesys Interactive Insights 8.1 
User’s Guide for a discussion of new examples on how to customize the 
universe and reports to meet business needs. 
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Chapter

1 Genesys Interactive 
Insights Overview 
Genesys Interactive Insights 8.1.x (GI2) uses the data that is stored in a 
Genesys Info Mart 8.1.x database and presents the data in readable reports to 
enable business and contact center managers to make better business decisions 
for streamlining operations, reducing costs, and providing better services. 

This chapter provides an overview of the relationships between the 
components that are required for GI2 8.1 operation and includes the following 
sections: 
 Presentation Layer for Genesys Info Mart, page 13 
 Genesys Info Mart 8.1, page 14 
 SAP BusinessObjects, page 15 
 Deploying GI2, page 17 

Presentation Layer for Genesys Info Mart 
GI2 is the presentation layer that Genesys has designed for the business-like 
interpretation of source data that is collected and stored in Info Mart. GI2 
provides a universe of over 600 defined agent-, agent-session-, campaign-, and 
queue-type measures and over 40 reports that summarize contact center 
activity. This functionality is delivered with the power of SAP BusinessObjects 
Enterprise (BO) XI 3.1 in Release 8.1.0 / 8.1.1, and SAP BusinessObjects 
Business Intelligence Platform (BI) 4.1 in Release 8.1.3 and later. Figure 1 
illustrates how the components that contribute to GI2 operation fit together. 

Refer to the Genesys Interactive Insights 8.1 Universe Guide for in-depth 
details about the Genesys-provided reports and measures. 
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Figure 1: BO Architecture Using GI2

Genesys Info Mart 8.1
GI2 pulls data directly from the Info Mart. So, for pure operation, GI2 requires 
that no other Genesys product be running in order for the GI2 reports to be 
scheduled, maintained, opened, and run. Only the Info Mart’s RDBMS and 
BusinessObjects (BO) software must be in operation. From a practical 
standpoint, however, Info Mart should be populated regularly with meaningful 
data that is sourced from contact center activities that are directed, monitored, 
and recorded by a number of Genesys products. 

The Genesys Info Mart Server extracts, transforms, and loads contact center 
data into fact tables at the most atomic, interaction level—enabling maximum 
flexibility of data interpretation. This low level of detail is good for tracking, 
verifying, and determining the contributing grains. But such detail is rarely 
useful for reporting and analysis of the performance of various contact center 
resources over a span of time, even as little as an hour. 
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The RAA engine—an optional Genesys Info Mart component that is 
mandatory for GI2 operation—compiles data from these FACT tables and stores 
it within several aggregate tables, based on the appropriate aggregation level 
(subhour [i.e., 30-minute], hour, day, and month) and type of data (disposition 
or interval). Refer to the Genesys Interactive insights User’s Guide for 
information about these measure types. Other aggregation levels are available 
as views. Use of these aggregates drastically improves query performance 
when you run the GI2 reports. 

The Info Mart schema was updated significantly in the Genesys Info Mart 8.x 
releases to enable measurement of threaded interactions, among other features. 
The GI2 8.x universe and reports reflect the changes and function properly 
when they are paired with an Info Mart that is based on the appropriate 
Genesys Info Mart 8.x schema. Table 3 on page 90 provides this mapping of 
GI2 release to Genesys Info Mart schema. Refer to the chapter of the Genesys 
Interactive Insights 8.1 Universe Guide for a list of the underlying Genesys 
Info Mart source tables of each GI2 report, as well as either: 

• The Genesys Info Mart 8.1 Reference Manual for your particular RDBMS 
type, for in-depth descriptions of the fact and dimension Info Mart tables 
and their columns.

• The Reporting and Analytics Aggregates 8.1 Reference Manual, for in-
depth descriptions of aggregation tables and their columns.

The 8.1 release of GI2 supports the generation of reports from Genesys Info 
Mart data sources that are managed by the following RDBMSs: 

• PostgreSQL 9.3

• Oracle 11g and 12c. 

• Oracle 11g RAC. 

• Microsoft SQL Server 2005, 2008, and 2012. 

Refer to the Genesys Supported Operating Environment Reference Guide for 
additional information about support and the Genesys Interoperability Guide 
for the minimum required releases of the necessary components. 

SAP BusinessObjects 
BO XI 3.1 is the business intelligence software that powers GI2 8.1.0 and 8.1.1 
For GI2 8.1.3 and 8.1.4, BI 4.1 is the driving software. The tools that are 
furnished within these software suites enable you easily and quickly to produce 
meaningful results, and provide analysis for more effective decision making. 

A full BO installation contains all of the components shown in Figure 2. Many 
of these components, however, are not used for GI2 operation. Figure 3 shows 
the minimum components that are required to use the GI2 universe and 
generate GI2 reports. 
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Figure 2: BO XI 3.1 Architecture

Refer to BO documentation for a complete description of these components. 

Figure 3: Minimum BO Components for GI2 Operation

Refer to “Server changes since XI x.x” in the Business Intelligence Platform 
Administrator Guide for the differences between different releases of XI. 
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Deploying GI2
To use GI2, you must perform, at minimum, two independent installations. A 
third independent installation is required if you choose to install BO apart from 
the installation of GI2: 

• Genesys Info Mart 8.1—You must have the Genesys Info Mart 8.1 CD (or 
image) to install Info Mart 8.1. Please refer to:
 The Genesys Info Mart 8.1 Deployment Guide and Genesys Info Mart 

Deployment Procedure for instructions on installing this product. 
 “Readying Genesys Info Mart for Aggregation” on page 29 of this 

document, for additional setup information. 
 The GI2 release advisory for the minimum required version of Genesys 

Info Mart 8.1 software. 

• SAP BusinessObjects Business Intelligence Platform—Refer to BO 
documentation for instructions on manually installing this software. Both 
silent and manual installations require the SAP BusinessObjects Business 
Intelligence Platform CD (or image). 

• GI2 8.1—You must have the Genesys Interactive Insights 8.1 CD (or 
image) to install the GI2 universe and reports. 

Refer to Chapter 4, “Installing Genesys Interactive Insights,” on page 63 of 
this document, for deployment instructions and Chapter 3, “Setting Up the 
Environment,” on page 29 for post-GI2 setup. 

The GI2 IP also includes Reporting and Analytics Aggregates (RAA) 8.1. 
A GI2 installation automatically and silently deploys RAA. You should not 
install RAA independently prior GI2 installation. Refer to the Reporting 
and Analytics Aggregates documentation set for information about this 
Genesys Info Mart option. 

Unlike most other Genesys products, the GI2 application is not configured 
within Configuration Server. 
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Chapter

2 Which BO Components 
Must Be Installed? 

The SAP BusinessObjects XI Installation Guide for Windows/UNIX describes 
how to deploy the suite of tools* that is provided with this software. Separate 
guides are provided for installation on both UNIX and Windows platforms. 
BusinessObjects (BO) documentation is available on the Genesys-provided 
BO documentation DVD and at http://help.sap.com on the Business Objects 
tab (for direct BO customers). Please consult either resource for installing the 
software. SAP BusinessObjects Business Intelligence Platform 4 
documentation is available from the following URL: 

http://help.sap.com/bobip41 

Only a subset of BO XI components, however, is needed to achieve full 
Genesys Interactive Insights (GI2) operation. The required components are 
predefined for you when you select to install BO, silently, as part of the GI2 
installation. Some other components of the BO XI suite, which are not required 
for GI2 installation, are not deployed when BO is installed together with GI2. 
For the instructions on installing BO in this manner, refer to Chapter  4, 
“Installing Genesys Interactive Insights”. 

Note: This chapter mostly applies to SAP BusinessObjects Enterprise (BO) 
XI 3.1. Regarding SAP BusinessObjects Business Intelligence 
Platform (BI) 4.1, Genesys does not provide its own installer 
consisting of mandatory-only components. Refer to SAP 
BusinessObjects Business Intelligence Platform 4 documentation for 
installation and upgrade instructions. 

*. Throughout this document, references to the BO XI suite or BO components apply to
either the SAP BusinessObjects XI 3.1 suite or the SAP BusinessObjects Business
Intelligence Platform 4.1 suite. 
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If you choose to install BO independent of a GI2 installation, you might be 
interested in knowing which BO components have no impact on GI2 operation. 
This information is indirectly provided in this chapter, which describes the BO 
XI 3.1 components that must be installed. This chapter includes the following 
sections: 
 Prerequisites, page 20 
 Required BusinessObjects Components, page 22 
 Installing BO Prior to Installing GI2, page 26 
 BO Service Packs, Fix Packs and Hot Fixes, page 27 
 Setting Up the BO Environment, page 27 

Prerequisites
To successfully install BO XI 3.1 or BusinessObjects Business Intelligence 
Platform (BI) 4.1, the following prerequisites must be met: 

• You must have the appropriate installation package, which is provided 
either directly from SAP or from Genesys. Furthermore, prior BO versions 
cannot pre-exist on your host. If you have a prior version, you should 
upgrade it, rather than install it anew. Refer to the BusinessObjects 
Enterprise Upgrade Guide for instructions. 

• Your operating system version must comply with a supported version. 

Supported platforms are provided in BO documentation. 

• Your environment meets or surpasses the minimum hardware and sizing 
requirements described in BO documentation for the various BO servers. 
For example: 
 BO XI 3.1 requires 2 GB RAM and up to 7 GB hard-disk space.
 BI 4.1 requires 16 GB RAM and up to 14 GB hard-disk space.

• Your environment meets or surpasses the minimum software requirements 
for the various server products described in BO documentation.

Note: BO XI 3.1 must be installed prior to, or in concert with, GI2 8.1.0 or 
8.1.1. 

Note: BO supports a wider range of platforms than does Genesys. 

Note: SAP BO supports connectivity to a wider range of RDBMSs than 
does Genesys. This release of GI2 restricts RDBMS support to 
those that currently are supported by Genesys Info Mart 8.1. This 
information is available in the Genesys Supported Operating 
Environment Reference Guide. 



Deployment Guide 21

Chapter 2: Which BO Components Must Be Installed? Prerequisites

UNIX Notes In addition, for UNIX platforms: 

• To install BO, you cannot be logged on as the root user. 

• The LOCALE setting of the UNIX shell must be set to Unicode encoding: 
 en_US.UTF-8 (for Solaris) 
 en_US.utf8 (for Linux) 

 Disable the Security Enhanced Linux feature for a RedHat 
Enterprises Linux operating system. 

The standard RHE installation enforces this feature by setting 
SELINUX=enforcing in the . /etc/sysconfig/selinux file. You must set this 
parameter to disabled and reboot the server in order for a BO installation 
to be successful.

• On Linux 5.x installations, make sure that the first line of the etc/hosts file 
contains the default string: 127.0.0.1 localhost.localdomain localhost.

The installation routine might vary slightly on different UNIX platforms and 
can take upward of an hour to complete on any platform. 

Obtaining Access
Parameters

Remember the access parameters that you specify when setting up the Central 
Management Server (CMS) during BO installation. Later, when you install 
GI2, you will need the BO administrator’s user name and password, as well as 
the host and port information, if the default values were not chosen. The 
defaults are: 

• User name: Administrator (This user must be named Administrator. 
Another user account with administrative permissions will not suffice.) 

• Password: <blank> 

• Host: Name of your computer 

• Port: 6400 

Genesys recommends that you specify a nonblank password. You can retrieve 
the port number from the Central Configuration Manager, as follows: 

1. Open the Central Configuration Manager, and right-click the Server 
Intelligence Agent application. 

2. Select Properties from the context menu that appears, and then select the 
Startup tab. 

The CMS port number appears in the Local CMS Servers frame, as shown in 
Figure 4. 
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Figure 4: Obtaining the CMS Port

Required BusinessObjects Components
This section lists the BO components that you must install for GI2 operation. 

Note: The BO license that Genesys provides is a restricted license. Refer to 
the licensing agreement for details on what data you can access when 
using this software. 

Note: Beginning with BO XI 3.1 Service Pack 5, the Genesys installer installs 
all BO components 
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A Full SAP BO XI 3.1 Deployment

A full deployment of SAP BO XI 3.1 software installs the following 
components: 

Client
Components

Server
Components

The listing of server components might vary slightly on the Linux platforms. 

Web Tier
Components

• Data Source Migration Wizard 

• Business View Manager 

• Report Conversion Tool 

• Import Wizard 

• Universe Designer 

• Desktop Intelligence 

• Web Intelligence Rich Client 

• Developer Components 
 BOE Java SDK* 
 BOE Web Services* 
 BOE .Net SDK 

• Publishing Wizard 

• Query as a Web Service 

• Translation Manager 

* With the exception of the noted components, all client components are available 
only on Microsoft Windows platforms. 

• Enterprise Servers 
 Central Management Server 
 Event Server 
 Input File Repository Server 
 Output File Repository Server 
 Crystal Reports Cache Server 
 Crystal Reports Processing 

Server 
 Publication Job Server 
 Report Application Server 
 Multi Dimensional Analysis 

Services Server 
 Crystal Reports Job Server 
 Destination Job Server

 List of Values Job Server
 Desktop Intelligence Job Server 
 Program Job Server 
 Adaptive Job Server 
 Adaptive Processing Server 
 Web Intelligence Processing 

Server (otherwise known as Web 
Intelligence Report Server) 

 Web Application Container 
Server (Windows only) 

 Desktop Intelligence Servers
 Dashboard and Analytics Servers
 Auditing Reports and Universes

• Central Configuration Manager 
(Windows only) 

• Mapping Support (Windows 
only) 

• BI Platform Web Components 

• BOE Web Services 

• Tomcat 
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In addition, a full deployment enables access to the following RDBMS types 
and the export of results to the following formats: 

Database Access

Export Support

The Required Set of BO XI 3.1 Components

Not all of the aforementioned client and server components interoperate with 
GI2. If you are manually installing BO, when prompted at the Select Features 
page of the BO XI 3.1 Setup Wizard, (shown in Figure 5), select, at minimum, 
the following components to install: 

Client
Components

• Data Federator 

• HP Neoview 

• MySQL 

• GenericODBC 

• Salesforce.com Driver 

• NETEZZA 

• Microsoft (Windows only) 

• IBM DB2 

• IBM Informix 
(includes Red Brick) 

• Progress OpenEdge 

• Oracle 

• Sybase 

• NCR Teradata 

• Character Separated Format 

• Disk File Destination 

• Rich Text Format 

• Word for Windows Format 

• Acrobat PDF Format 

• Text Format 

• Excel Format 

• Crystal Reports Format 

• XML Export 

• Legacy XML Export 

• Import Wizard 

• Universe Designer 

• Web Intelligence Rich Client 

• Developer Components 
 BOE Java SDK* 
 BOE Web Services* 
 BOE .Net SDK 

* With the exception of the noted components, all client components are available 
only on Microsoft Windows platforms. 
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Web Tier
Components

For Web tier components, select any of the provided choices. 

 

Figure 5: Select BO Features

Server
Components

Database Access For database access, GI2 supports connectivity to the following RDBMSs, as 
supported in the Genesys Info Mart 8.1.x releases:  

Refer to the Genesys Supported Operating Environment Reference Guide for 
the specific supported versions. 

• Central Configuration Manager 
(Microsoft Windows only) 

• Central Management Server 

• Event Server 

• Job Servers 
 Publication 
 Destination 
 List of Values 

 Program 
 Adaptive 

• Report Application Server 

• Input File Repository Server 

• Output File Repository Server 

• Web Intelligence Processing Server 

• Adaptive Processing Server 

• Dashboard and Analytics Servers 

• Auditing Reports and Universes 

• Microsoft SQL Server 

• Oracle
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In addition to one (or more) of these RDBMSs, select, at minimum: 

• MySQL, as this RDBMS is used for communication with the CMS 
database. 

• Generic ODBC, which is used also by CMS. 

Export Support If you intend to export report results, select any or all of the appropriate output 
formats that are provided at the Select Features page. 

Installing BO Prior to Installing GI2
A complete version of BO software is provided among the software that is 
bundled with GI2. Instructions for installing the complete version of this 
software are provided in BusinessObjects documentation—specifically, within 
the following documents: 

SAP BusinessObjects Enterprise XI 3.1 4

• SAP BusinessObjects Enterprise XI 3.1 Installation Guide for Windows 

• SAP BusinessObjects Enterprise XI 3.1 Installation Guide for UNIX 

• SAP BusinessObjects Enterprise 5/6 to XI 3.1 Migration Guide 

• SAP BusinessObjects Enterprise Upgrade Guide 

SAP BusinessObjects Business Intelligence Platform 4

• Installation Guide for Windows 

• Installation Guide for UNIX 

Indeed, you must install the complete version if you want more functionality 
than that which is provided by the standard Genesys configuration of BO for 
GI2. This standard configuration specifies the following: 

• English language 

• Tomcat application server 

• Sybase SQL Anywhere 12.0.1 (installed by default as the DBMS for the 
Central Management Server (CMS), for all platforms) 

• Administrator, as the name of the CMS administrative user 

In addition, in order to use other tools of the BO XI suite that GI2 neither uses 
nor installs (such as Crystal Reports), you must install BO independently from 
GI2. Keep in mind, though, that deployment of the full version of BO still 
binds you to the limited licensing agreement regarding its use, which is 
described under “Licensing Restrictions” in the Genesys Interactive Insights 
8.1 User’s Guide. 

However, Genesys provides the opportunity to install BO silently using the 
GI2 installation routine, which is described beginning on page 63. The silent 
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installation deploys fewer components of the BO XI suite. This option might 
be more desirable to preserve system resources and hard disk space. 

BO Service Packs, Fix Packs and 
Hot Fixes

To fully appreciate the functionality that GI2 software provides, Genesys 
requires that you install the latest service and fix packs for BO software that 
have been validated by Genesys Quality Assurance. If you are a direct BO 
customer—that is, if you purchased BO software directly from SAP—other, 
more recent service or fix packs might be available to you, in addition to those 
that come bundled with GI2. Please note that GI2 software might respond 
differently from what you might expect when used in conjunction with service 
and fix packs that are not tested by Genesys. Please refer to Table 3 on page 90 
to learn about the BO software that is recommended for operation with GI2 
8.1. 

In addition to BO-provided packs, Genesys might provide hot fixes to BO 
software that are not available to the general BO public. Any such hot fixes 
would be described in the SAP BusinessObjects Business Intelligence Platform 
Server/Client Hot Fix Release Notes if such a hot fix exists. 

Setting Up the BO Environment 
Refer to the SAP BusinessObjects Enterprise XI 3.1 Administrator’s Guide or 
the Business Intelligence Platform Administrator Guide to set up the 
administrative functions for using BO software, including: 

• Setting rights. 

• Managing user accounts and groups. 

• Managing data sources and connections. 

• Managing objects. 

• Scheduling objects. 

• Managing profiles. 

• Row-level and column-level security. 
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The reports and universe that are deployed later during GI2 installation are 
initially available only to the following users: 

• Administrator 

• Developer 

• Editor 

• Viewer 

• Basic 

Other users, their roles, and access to the reports and to the universe are set up 
in accordance with your company’s policy. For multi-tenant environments, 
consider creating separate groups (at minimum) for each tenant, so as to align 
with the manner in which universe connections to the Genesys Info Mart 
should be defined. 

Refer to page 44 for information about the GI2 groups and users that are 
provided in the GI2 BusinessObjects archive. 

Note: Preferences and permissions for BO components that are not required 
for GI2 operations—such as Crystal Reports and Xcelsius—may be 
disregarded. 
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After you have installed Genesys Interactive Insights (GI2), you must run 
additional setup steps manually before you operate the GI2 reports. This 
chapter describes these steps in the following sections: 
 Readying Genesys Info Mart for Aggregation, page 29 
 Utility Views Specific to GI2, page 30 
 Customizing BO, page 31 
 Setting Up Attached Data, page 32 
 Linking the Universe to Your Data Mart, page 32 
 Manually Setting Up GI2 Access Levels, Groups, and Permissions, 

page 44 
 Setting Data-Access Restrictions for Multi-Tenant Environments, page 52 
 Setting Integrated Data Access Restrictions, page 56
 Translating the Universe, GI2 Reports, and BO GUI, page 59 
 Customizing Measure Definitions, page 62 

Readying Genesys Info Mart for 
Aggregation

A Genesys Info Mart 8.1 installation that has the Reporting and Analytics 
Aggregates (RAA) option deployed contains the tables and views that are 
referenced by the GI2 reports. To prepare the Genesys Info Mart environment 
for GI2 operation, you must perform additional setup steps, including: 

• Repositioning the \agg subdirectory. 

• Setting aggregation-related configuration options. 
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Reposition the \agg Subdirectory

The GI2 installation routine deploys the \agg subdirectory to the Interactive 
Insights root folder. This subdirectory and its contents, however, must be 
placed in the Genesys Info Mart root folder in order to be recognized by 
Genesys Info Mart. Copy this directory to the Genesys Info Mart root folder. 

Set Aggregation-Related Options

To enable aggregation, you must appropriately set aggregation-related 
configuration options (such as aggregation-engine-class-name, run-
aggregates, and business-specific thresholds) in the Genesys Info Mart 
application object in Configuration Manager. These options are described in 
the Reporting and Analytics Aggregates 8.1 Deployment Guide. 

Utility Views Specific to GI2
Running aggregation for the first time executes an internal script against your 
Genesys Info Mart database to set up the necessary views for the GI2 reports. 

Among the views created for this purpose are the following: 

Genesys Info Mart Multi-Tenant Environments

For Genesys Info Mart environments that contain more than one tenant, run 
RAA with the updateAliases runtime parameter to create tenant views of GI2 
objects. For a description of this parameter and an example of its use, refer to 
the Reporting and Analytics Aggregates 8.1 Deployment Guide and the 
Reporting and Analytics Aggregates 8.1 User's Guide, respectively. 

Note: It is no longer necessary to execute the make_gi2.sql script against 
Genesys Info Mart manually. Beginning with release 8.0.001.02, the 
aggregation engine performs this task automatically upon first run. 

• TODAY 

• RELATIVE_RANGE 

• GI2_CONSTANTS 

• INTERACTION_DESCRIPTOR_GI2 

• INTERACTION_FACT_GI2 

• INTERACTION_RESOURCE_FACT_GI2 

• INTERACTION_RESOURCE_STATE_GI2

• INTERACTION_TYPE_GI2 

• IXN_RESOURCE_STATE_FACT_GI2 

• MEDIATION_SEGMENT_FACT_GI2 

• RESOURCE_GI2 

• RESOURCE_STATE_REASON_GI2 

• SM_RES_SESSION_FACT_GI2 

• SM_RES_STATE_FACT_GI2 

• SM_RES_STATE_REASON_FACT_GI2 
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Customizing BO 
Use the information in this section to apply, or re-apply, customizations to BO. 

After Full Installation

The GI2 installation routine silently runs the script gi2_customize_bo.bat/sh to 
customize the appearance of BO, which also replaces some files in the BI 
Tomcat webapps directory. After installation, complete the following steps to 
restore the contents of the BI Tomcat webapps directory:

1. Stop Tomcat. 

2. Delete the directory 'BOE_TOMCAT_ROOT%\work\Catalina\localhost\BOE

3. Restart Tomcat 

After Fix Pack Installation

The fix packs that are provided by SAP come with their own installer. The 
latest supported fix pack, if any, is provided in the Genesys-provided 
installation package (IP). This software provides a patch to BO software that 
you manually after BO installation. Instructions for installing the fix pack are 
provided with the IP. 

If you install this fix pack after installation of GI2, you must also re-execute 
the gi2_customize_bo script. (This script is described on page 108.) 

1. Execute the gi2_customize_bo script.

2. Stop Tomcat. 

3. Delete the directory 'BOE_TOMCAT_ROOT%\work\Catalina\localhost\BOE

4. Restart Tomcat 

After 8.1.3 or 8.1.4 Installation

Perform the following customization steps only on GI2 8.1.3, and later, 
deployments. 

Customizing Date and Time Display

Optionally, you can configure the date and time values that appear in GI2 
reports. By default, the prompts for dates and times do not save custom values 
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you enter, and reports always show default date and time values. To change 
this behavior, complete the following steps:

1. Open the Information Design Tool.

2. In the GI2 universe, enable Keep Last Value for the following date/time 
related parameters: 
Pre-set Day Filter, Pre-set Date Filter, Start Date, End Date, 

Report Date.

3. Restart the BO server.

Customizing GI2 User Rights

Use this procedure to manually configure rights that are not provided in the 
LCMBIAR. 

1. Start the Central Management Console (CMC) 

2. On the Applications tab, right click on the Central Management Console 
application element, and in the context menu, select CMC Tab Access 
Configuration.

3. In the CMC Tab Access Configuration: CMC dialog box, select Restricted, 
and click Save.

4. Set the following permissions:
 Inboxes: For each GI2 user, select User Security -> Add Principal, 

and assign the user access level Full Control (Owner).
 Personal Folders: For each GI2 user, select User Security -> Add 

Principal, and assign the user access level Full Control (Owner).

Setting Up Attached Data
The 8.1 release introduced new reports that are heavily based on the 
configuration of user data in your environment. User data is highly 
customizeable within any given environment. To use the GI2 reports without 
modifying the universe or measure definitions, you must configure userdata 
data structures within Genesys Info Mart in a specific manner. The 
“Configuring Social Media User Data” section in the Genesys Interactive 
Insights 8.1 User's Guide provides a complete example that demonstrates how. 

Linking the Universe to Your Data Mart
The GI2 reports call upon measures that were designed using BusinessObjects 
Universe Designer, hereinafter simply referred to as Designer. These measures 
are predefined in the GI2 universe that you imported but they are not pre-
connected to your specific Genesys data source out of the box. You must 
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define such a connection and assign it within Designer so that the reports that 
reference these measures will pull contact center data from your Info Mart. 

Importing the Universe to Designer
 

There are many ways to define database connections. The first step, however, 
is to import the GI2 universe to your local Designer application, as follows: 

1. From the Start menu, select BusinessObjects XI 3.1, BusinessObjects 
Enterprise, and then Designer. 

2. At the User Identification dialog box, specify connectivity parameters to 
CMS, and click OK. If the port number is different from the default, you 
must specify it along with the host in the System field—for example, 
tp42003-3:6402. 

3. At the Quick Design Wizard – Welcome Screen, click Cancel. 

4. From the File menu, click Import. 

5. At the Import Universe dialog box, click the Browse button to open the 
Select a Universe Folder dialog box.

6. Select the appropriate release-specific, Interactive Insights subfolder, and 
click OK. For example, Figure 6 on page 34 shows the 8.1.1 folder selected 
for the techpubs4 host in this dialog box. 

Note: The GI2_GIM_DB connection that the GI2 installation routine deploys is 
reserved for Genesys use. Do not use this connection. 

Note: For SAP BusinessObjects Business Intelligence Platform (BI) 4.1, 
refer to Information Design Tool User Guide for information on how 
to import a universe using this tool. This section describes how to 
input the GI2 universe using Designer. 
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Figure 6: The Root Folder of the BO Repository

7. Select the GI2_Universe universe from the Available Universes frame, and 
click OK. 

Designer imports the universe and displays its classes, objects, and table 
relationships in the Universe Window. A local copy of the universe is now 
available on your workstation for viewing and editing universe elements. Any 
changes you make to the definitions of universe elements will have to be 
ported back to the repository after editing. See “Customizing Measure 
Definitions” on page 62 and “Exporting the Universe Back to the Repository” 
on page 43 for further information. 
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Defining a New Connection (BO XI 3.1)

Use the following steps to define a connection to link these universe objects to 
the tables in your Data Mart. This procedure describes the steps for 
establishing an Oracle Client data source connection. 

The steps and the pages of the New Connection Wizard might be different for 
other driver types: 

1. From the Tools menu, select Connections. The Connections List page of 
the Wizard Connection displays. 

2. Click the Add button to start the New Connection Wizard. 

3. On the Welcome page, click Next. 

4. At the Database Middleware Selection page, type a unique name for your 
data source connection, select the driver for the RDBMS type of your 
Genesys data source, and click Next. Figure 7 illustrates the creation of the 
TechPubs4 connection. 

5. At the Login Parameters page, specify the connectivity parameters to the 
desired database schema of your Info Mart, and click Next. 

The parameters that you specify may be to the owner’s schema, which 
would enable users to generate and display the results of several tenants in 
one report. 

6. At the Configuration Parameters page, define advanced parameters for 
accessing the data mart and click Next. 

7. Specify any custom parameters at the Custom Parameters page, and click 
Finish. 

The Custom Parameters page closes, and focus returns to the Connections 
List page of the Wizard Connection. 

Note: For Microsoft SQL Server, Genesys recommends that you use the 
following drivers to configure a connection to the GI2 Universe:

• For Windows, OLE DB drivers

• For UNIX, JDBC drivers

Note: This step does not appear for all driver types. 
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Figure 7: Defining an Oracle Client Connection

8. For multi-tenant environments in which you have prepared Info Mart read-
only views for tenants, repeat Steps 2 through 6 to define a connection for 
each tenant schema in your Info Mart (or to each tenant’s database, 
depending on your particular RDBMS type). 

This connection will restrict one tenant’s access, so that the tenant cannot 
view another tenant’s data. 

9. Select your connection from the connections list, test it if you want, and 
click Finish. 

This connection has been defined for your local workstation, but you must 
assign it to the GI2 universe and export the universe back to the BO 
repository for the connection to be available to others who might run 
reports. Refer to the “Connecting to Your Data Source (BO XI 3.1)” and 
“Exporting the Universe Back to the Repository” sections that follow. 

10. Within CMC from the Connections section, grant View on Demand access 
for your group to the connection(s). 
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Connecting to Your Data Source (BO XI 3.1)

In BO XI 3.1 deployments, if you created a connection from the“Defining a 
New Connection (BO XI 3.1)” section or already have defined a connection to 
your data source, use it to connect to the GI2 universe: 

1. From the File menu in Designer, select Parameters. The Universe 
Parameters dialog box displays. 

2. Select your connection from the Connection dropdown list box, test it if 
you want, and click OK. 

3. Save the universe (File > Save). 

Figure 8 shows a user selecting the TechPubs4 connection, which was created 
earlier under “Defining a New Connection (BO XI 3.1)” (Step 4 on page 35). 

Figure 8: Setting the Connection 

Defining a New Connection (BI 4.1)

In BI 4.1 deployments, use this procedure to define a new Connection, which 
you can use to link the universe objects to the tables in your Data Mart. 
Alternatively, you can reuse the default Connection by following the steps in 
“Using the Default Connection (BI 4.1)” on page 39.

Note: Connecting to a specific tenant’s schema will prevent you from 
viewing results across other tenants. You must specify the connection 
that has been established for the owner’s schema in order to view the 
results from multiple tenants in one report. 
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1. Open the Information Design Tool.

2. On the Repository Resources tab, click Open session, or click + (Insert), 
and select Insert Session, as shown in Figure 9.

Figure 9: Insert Session

The Open Session dialog box appears.

3. In the System field, enter the BI instance name. Enter the User Name 
(Administrator) and associated Password, and click OK.

4. Click + (Insert), and select Insert Relation Connection, as shown in 
Figure 10. The New Relational Connection dialog box appears.

Figure 10: Connections Folder

5. Type a name for the new connection, and click Next.

6. Select the appropriate driver for your database middleware, and click Next.

7. Enter appropriate connection parameters. The parameters available vary 
depending on the driver type you selected for the connection; Figure 11 
shows parameters for MSSQL server:

Figure 11: New Relational Connection Parameters
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8. Test the connection before clicking Next.

9. Click Finish.
The created connection appears in the list of available connections for the 
BI server, as shown in Figure 12.

Figure 12: The New Connection

Next, link your connection to the universe by using the steps in “Connecting to 
the GI2 Universe (BI 4.1)” on page 41.

Using the Default Connection (BI 4.1)

In BI 4.1 deployments, use this procedure to update the default GI2_GIM_DB 
Connection to point to your data source, so that you can link the universe 
objects to the tables in your Data Mart. Alternatively, you can create a new 
Connection by following the steps in “Defining a New Connection (BI 4.1)” 
on page 37.

1. Open the Information Design Tool.

2. Select File > New > Project. Enter the Project Name, and click Finish. A 
new project is created, and appears on the Local Project tab.

3. On the Repository Resources tab, click Insert Session.

4. In the System field, enter the BI instance name. Enter the User name 
(Administrator) and associated password, and click OK.
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5. Open the Connections folder, and select the GI2_GIM_DB connection, as 
shown in Figure 13.

Figure 13: Connections Folder

6. Click the right mouse button and, in the context menu, select Open item.

7. Click Change Driver, select a driver, and enter appropriate connection 
parameters.

8. Test the connection, then choose File > Save to save the connection.

9. Close the Connection tab.

10. Open the folder:
Universes > GI2_Universe > Interactive Insights > 8.1.4.

11. Select GI2_Universe.unx, click the right mouse button, and in the context 
menu select Retrieve Universe.

12. Select the project created in Step 2, and click OK.

13. In your local project folder, open the newly-created folder, which has a 
name in the format retrieval-<date>, such as retrieval-2014-12-24-19-
08-50, as shown in Figure 14.

Figure 14: Local Projects

14. Select the GI2_Universe.blx element, click the right mouse button and 
from the context menu, select Publish > To Repository…
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15. In the Check Universe Integrity dialog, click Next.

16. Open the folder:
GI2_Universe - Interactive Insights\8.1.4\

and select GI2_Universe.unx.

17. Click Finish
The message Do you want overwrite universe? appears. 

18. Click Yes, and close the dialog box.

Next, link your connection to the universe by using the steps in “Connecting to 
the GI2 Universe (BI 4.1)” on page 41.

Connecting to the GI2 Universe (BI 4.1)

In BI 4.1 deployments, once you have created a Connection (“Defining a New 
Connection (BI 4.1)” on page 37 or “Using the Default Connection (BI 4.1)” 
on page 39), use this procedure to link the universe objects to the Connection. 

1. Open the Information Design Tool.

2. Select File > New > Project. Enter a Project Name, and click Finish. A 
new project is created, and appears on the Local Project tab.

3. On the Repository Resources tab, click + (Insert) > Insert Session, as 
shown in Figure 15. The Open Session dialog box appears. 

Figure 15: Connections Folder

4. In the System field, enter the BI instance name. Enter the User Name 
(Administrator) and associated Password, and click OK.
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5. Still on the Repository Resources tab, right-click on file:
Universes > GI2_Universe > Interactive Insights > 8.1.4 > 

GI2_Universe.unx and select Retrieve Universe, as shown in Figure 16. 
The Select A Local Project dialog box appears.

Figure 16: Retrieve Universe

6. Select the project created in Step 2, and click OK.
On the Local Project tab, the newly created folder appears with a name in 
the format retrieval-<date> (such as retrieval-2014-12-24-19-08-50). 

7. Open the newly-created folder, right click the GI2_GIM_DB.cns element, and 
select Open, as shown in Figure 17. The General Information tab for the 
GI2_GIM_DB.cns element appears.

Figure 17: Open GI2_GIM_DB.cns 

8. Click Change Connection. The Change Connection dialog box appears.

9. Click Change Connection to verify that the connection is working correctly.

10. Click File > Save to save the connection.

11. On the Local Projects tab, right-click on the GI2_Universe.blx element, 
and select Publish > To Repository.

12. The Check Universe Integrity dialog box appears. Click Next, and on the 
next page, select the file 
GI2_Universe > Interactive Insights > 8.1.4 > GI2_Universe.unx 

13. Click Finish. The Do you want to overwrite universe? confirmation 
dialog appears. Click Yes, and close the dialog box. 
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Exporting the Universe Back to the Repository

The changes that you make to the universe are local. To make them available 
to others who might run reports, you must export the universe back to the 
repository, as follows: 

1. From the File menu, select Export. The Export Universe dialog box 
displays, as shown in Figure 18. 

2. From the Groups frame, select all of the groups to which this connection 
applies. 

3. From the Universes frame, select the name of your universe (for example, 
GI2_Universe), and click OK. 

Figure 18: Exporting Changes Back to the Repository

The updated universe—with connection to your data source defined—is now 
available to the user groups that you specified. 
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Manually Setting Up GI2 Access Levels, 
Groups, and Permissions

The GI2 installation routine silently deploys the GI2 objects that are stored in 
the insights.biar file as well as the permissions assigned to these and other 
objects. Among these objects are the following GI2 groups and users (and 
passwords): 

If you want to import these objects or change their permissions manually, as 
the BO administrator, you can either use the Import Wizard to import these 
objects with their permissions applied to universe elements (see “Manually 
Importing Objects and Data Elements” on page 73), or create the objects 
yourself from scratch and assign permissions to various objects by following 
the instructions in these sections: 

• “Setting Up Access Levels” on page 45 

• “Creating GI2 Groups” on page 47 

• “Hiding Unused Folders” on page 48 

• “Setting Permissions for BO Objects” on page 50 

After importation, you can view the GI2 users and groups in the Central 
Management Console (CMC). Figure 19 shows the added groups. 

Consider changing the passwords of the default users if you are concerned 
about security. 

Group User (Default Password)
• Interactive Insights report developers 

• Interactive Insights report editors 

• Interactive Insights report viewers 

• Developer (gi2_user) 

• Editor (gi2_user) 

• Viewer (gi2_user) 

Note: If your installation of GI2 was successful, prior to importing the 
universe manually by using the Import Wizard, remove any GI2 objects 
that exist in the BO repository, so as to avoid creating duplicate objects 
(following Step 3 on page 104). 
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Figure 19: Viewing the Default BO and GI2 Groups in CMC

Setting Up Access Levels 

If you opt not run the Import Wizard to deploy the Interactive Insights report 
access levels (which are groupings of permissions that are applied to groups 
and/or users), as the administrative user within the CMC, you can create them 
manually. GI2 predefines the following access levels: 

• Interactive Insights report developer access level 

• Interactive Insights report editor access level 

• Interactive Insights report viewer access level 

Though these access levels correspond to the three GI2 groups, the access 
levels are progressive—that is, they build upon the access levels of others. 

To manually create these access levels, perform the following steps within the 
Central Management Console: 

1. Select the Access Levels section. 

2. Click Manage > New > Create Access Level. 

3. Name the access level “Interactive Insights report developer access 
level”, and click OK. 

4. Double-click the access level that you just created to open its properties. 

5. Under Included Rights, click Add/Remove Rights, select the appropriate 
rights for each collection (shown in Table 1), and then, click OK. 

(In Table 1, a checkmark signifies that a right was selected; an X signifies 
that the right was blocked for the indicated access level.) 

6. Click Close to save the definition. 
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7. Repeat Steps 2–6 for the remaining two GI2 access levels. 

Table 1: Definitions of the Predefined Interactive Insights Access Levels

Collection Type Name of Right Access Levels*

D E V

System Connection Data Access ✓ ✓ ✓

General General Add objects to folders that the users owns ✓ ✓

Add objects to the folder ✓ ✓

Copy objects that the user owns to another folder ✓ ✓

Copy objects to another folder ✓ ✓

Delete instance ✓

Delete instances that the user owns ✓

Delete objects ✓

Delete objects that the user owns ✓

Edit objects ✓ ✓

Edit objects that the user owns ✓ ✓ ✓

Modify the rights users have to objects ✓

Modify the rights users have to objects that the user owns ✓

Schedule document that the user owns ✓

Application WebI Data Tracking: Enable for users ✕

Data Tracking: Enable format display changes by users ✕

Enable drill mode ✓ ✓

Enable formula and variable creation ✕

Enable HTML Report Panel ✓ ✕

Enable interactive HTML viewing (if license permits) ✕

Enable Java Report Panel ✕

Enable Query - HTML ✕

Extend scope of analysis ✓ ✓

Edit this object ✓

Interactive: Formatting - Enable toolbar and menus ✕

Interactive: General - Ability to hide / show toolbars ✕

Interactive: General - Edit 'My Preferences' ✕

Interactive: General - Enable right click menu ✕

Interactive: Left pane - Enable available objects, tables and 
charts

✕

Interactive: Left pane - Enable data summary ✕

Interactive: Left pane - Enable document structure and filters ✕

Interactive: Left pane - Enable document summary ✕

Interactive: Reporting - Apply and remove existing alerts ✕

Interactive: Reporting - Create and edit break ✕

Interactive: Reporting - Create and edit predefined calculation ✕

Application WebI Interactive: Reporting - Create and edit report filter ✕
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Creating GI2 Groups 

In addition to the Interactive Insights access levels, the Import Wizard also 
deploys GI2 user groups. You can create them manually and add users as 
follows: 

1. Select the Users and Groups section and, over the Group List item, right-
click New Group. 

2. At the Create New User Group page, type the following, and then click OK: 

a. In the Group Name field, type Interactive Insights report 
developers. 

b. In the Description field, provide an appropriate description.

3. Right-click Interactive Insights report developers; then, from the 
context menu that appears, select User Security. 

4. Click the Add Principals button. 

5. On the Add Principals page, mark the Users radio button. 

Interactive: Reporting - Create and edit sort ✕

Interactive: Reporting - Insert and remove report, table, chart 
and cell

✕

View SQL ✕

Web Intelligence Rich Client: Save a document locally on the 
file system

✕

Web Intelligence Rich Client: Create a document ✕

Web Intelligence Rich Client: Enable a client to use it ✕

Web Intelligence Rich Client: Export a document ✕

Web Intelligence Rich Client: Import a document ✕

Web Intelligence Rich Client: Print a document ✕

Web Intelligence Rich Client: Save a document for all users ✕

Web Intelligence Rich Client: Send by mail ✕

Content WebI Edit Query ✓

View SQL ✓

Export the report's data ✓

Refresh List of Values ✓

Refresh the report's data ✓

Save as CSV ✓

*. D=Interactive Insights report developer access level
E=Interactive Insights report editor access level 
V=Interactive Insights report viewer access level 

Table 1: Definitions of the Predefined Interactive Insights Access Levels (Continued) 

Collection Type Name of Right Access Levels*

D E V
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6. From the Available users/groups list box, select Developer and any other 
user who belongs to this group, and move it to the Selected users/groups 
list box. 

7. Click Add and Assign Security, and click OK twice. 

8. Click Close to close the user security properties. 

9. Repeat Steps 2–8 to create the following user groups: 
 Interactive Insights report editors 
 Interactive Insights report viewers 

To maintain flexibility, permissions (other than the default) are not assigned to 
the GI2 users or groups. Instead, Genesys recommends that you assign 
permissions directly to the objects that users access. This procedure is 
described in “Setting Permissions for BO Objects” on page 50. 

Hiding Unused Folders

BusinessObjects Enterprise (BO) XI 3.1 software includes folders that are not 
used by GI2. Among them are the following:

To hide these folders from users in the GI2 report groups, as the administrative 
user within the Central Management Console, under the Folders section, 
perform the following steps for each folder:

1. Right-click the desired folder; then, from the context menu that appears, 
select User Security. 

2. Click the Add Principals button. 

The Add Principals page appears, as shown in Figure 20. 

• Administration Tools 

• Auditor 

• Feature Samples 

• Report Conversion Tool 

• Report Samples 

• Search Program 
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Figure 20: Adding Principals to a Folder’s Security Profile

3. Mark the Groups radio button. 

4. From the Available users/groups list box, select the three GI2 user 
groups, and move them to the Selected users/groups list box. 

5. Click the Add and Assign Security button. 

The Assign Security page appears, as shown in Figure 21.
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Figure 21: Assigning Access Levels to Folders for Selected Principals

6. Clear the Inherit From Parent Folder and Inherit From Parent Group 
boxes, and click OK. 

Because no access levels were explicitly selected, CMC displays a dialog 
box that prompts you to confirm this action. 

7. At the confirmation box, click OK. 

CMC returns to the User Security properties of your selected folder and 
displays the added groups. 

8. Click Close. 

With these changes applied to each folder, the folders will be invisible to GI2 
users within InfoView and Web Intelligence. Note that administrative users, 
having full control, will continue to see them. 

Setting Permissions for BO Objects 

You can manually set permissions on the objects used by GI2, including the 
universe, the Interactive Insights folder and connection, and even the InfoView 
and Web Intelligence applications. Table 2 on page 51 lists the user security 
properties of objects that the GI2 installation routine sets. To set these 
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manually, perform the following steps within Central Management Console as 
the administrative user: 

1. You can set top level security for root objects or user security for other 
objects: 
 To set top level security, open the appropriate CMC section, select 

Manage > Top-Level Security > All <Objects>. 
 To set user permissions, open the appropriate CMC section, right-click 

the desired object from that section, and select User Security. 

2. Click the Add Principals button, and mark the Groups radio button. 

3. From the Available users/groups list box, select the groups indicated for 
the object from Table 2 and move them to the Selected users/groups list 
box. 

4. Click the Add and Assign Security button, either clear or mark the Inherit 
From Parent Folder and Inherit From Parent Group boxes as indicated in 
Table 2 for the object, and apply your changes. 

a. Under the Access Levels tab, select the appropriate access level from 
the Available Access Levels list, and move it to the Assigned Access 
Levels list: 

b. Apply your changes, and click OK. 

5. Click Close to close the user security properties. 

Table 2: Mapping of Access Levels to BO Objects

CMC 
Section Object Name Principal*

Inheritance From ... Access Level† 

Parent 
Folder

Parent 
Group

D E V Full V VOD

Connections < Connections root folder > Developers ✕ ✕ ✕ ✕

GI2_GIM_DB Editors ✕ ✕ ✕

Viewers ✕ ✕ ✕

Universes < Universe root folder > Developers ✕ ✕ ✕

Interactive Insights [folder] Developers ✕ ✕ ✕

GI2_Universe Editors ✕ ✕ ✕ ✕

Viewers ✕ ✕ ✕
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Setting Data-Access Restrictions for 
Multi-Tenant Environments

In addition to the permissions that you can set within CMC to control access to 
various BO repository elements, you can also set restrictions on user access to 
data by limiting the objects, rows, query types, and connections that are 
available to users through the Designer application. BO defines a restriction as 
a named group of constraints that can be applied to a group or user account for 
a universe. 

Through the use of restrictions, administrators can affect who sees which data 
in the GI2 reports. This is a particularly useful feature when it is applied to a 

Applications Web Intelligence Developers ✕ ✕ ✕

Editors ✕ ✕ ✕

Viewers ✕ ✕ ✕

InfoView Developers ✕ ✕ ✕

Editors ✕ ✕ ✕

Viewers ✕ ✕ ✕

Designer Developers ✕ ✕ ✕

Folders < InfoView root > Developers ✕ ✕ ✕

Editors ✕ ✕ ✕

Viewers ✕ ✕ ✕

Interactive Insights Developers ✓ ✕ ✕ ✕ ✕

Editors ✓ ✕ ✕ ✕

Viewers ✓ ✕ ✕

* Principals
Interactive Insights report developers
Interactive Insights report viewers
Interactive Insights report editors

† Access Levels
D= Interactive Insights report developer 
access level
E = Interactive Insights report editor ac-
cess level
V = Interactive Insights report viewer 
access level 

Full = Full Control
V = View
VOD = View On 
Demand

Table 2: Mapping of Access Levels to BO Objects (Continued) 

CMC 
Section Object Name Principal*

Inheritance From ... Access Level† 

Parent 
Folder

Parent 
Group

D E V Full V VOD
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data source that stores data for more than one tenant. For instance, within one 
universe, an administrator can define several connections —each of which 
accesses a different tenant view within the same Info Mart—and then create 
and apply connection restrictions to each tenant to ensure that its users see only 
the data that is pertinent to that tenant. 

The login to Web Intelligence identifies the user (and hence the user group) 
and the access permissions that are assigned to that user within the repository; 
the restriction defines which connection the user can use to access data within 
a specific universe. No changes to the definitions of dimensions or measures, 
for instance, or to the design of the reports would be required to provide 
tenant-specific data in your reports. 

The benefits of this one-universe approach should be obvious—for example: 

• Consistency in measure definitions across the enterprise. 

• Reduced maintenance costs—having to manage only one universe (instead 
of one universe per tenant). 

• Single source. 

• Optimized use of network resources. 

Creating Users and Groups in Multi-Tenant Environments

The steps that are provided on page 44 describe the procedures for creating 
GI2 users and groups and assigning users and groups to various repository 
elements. The naming convention that was used for the users and groups and 
the presentation of the steps were biased toward setup of a single-tenant 

Note: Genesys Info Mart supports several methods of configuring multi-
tenant environments, including:
• A separate schema per tenant. 
• A separate schema for each group of tenants. 
• One database/one schema for all tenants (where each tenant can see 

other tenants’ data). 

Configuration depends largely on the capabilities that are provided by 
your chosen RDBMS and on the data access security measures that are 
established within your enterprise. Please refer to the Genesys Info 
Mart 8.1 Deployment Guide for further information. 

One possible configuration, however, is particularly noteworthy for a 
Microsoft SQL 2005 RDBMS. In the scenario in which a separate 
schema has been created within one database for each tenant, you must 
ensure that individual tenant logins map to the respective database 
owner for the tenant schema or that the default schema for each tenant 
login matches that of the owner for that schema. Furthermore, this 
login cannot be sysadmin; otherwise, elements in the GI2 universe 
might point to an unintended set of objects in Info Mart. 
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environment. However, with the exception of the names that you choose for 
users/groups, the procedures are identical for multi-tenant environments. 

1. If you have not done so already, complete the steps that are defined in the 
following sections to add GI2 views to each tenant schema (or database, as 
applicable) and to define connections to them, respectively: 
 “Utility Views Specific to GI2” on page 30 
 “Linking the Universe to Your Data Mart” on page 32 

2. To set up users and groups for your tenants, follow the steps that are 
provided in “Manually Setting Up GI2 Access Levels, Groups, 
and Permissions” on page 44—again, choosing tenant-identifying names, 
such as: 
 Tenant1 Report Viewers (group) and 
 Tenant1 Viewer (user) 

Creating Connection Restrictions

Within Designer, administrators can create and define restrictions in the Manage 
Access Restrictions dialog box, which is shown in Figure 22. 

To create a connection restriction and apply it to the tenant users and groups 
that you created earlier in Step 2 (above): 

1. From the Tools menu within Designer, select Manage security > Manage 
Access Restrictions. The Manage Access Restrictions dialog box 
appears. 

2. Click New to open the Edit Restrictions dialog box, in which you can 
create a new restriction. 

3. In the Restriction Name field, name the restriction for a particular tenant 
appropriately—for example, Tenant1 Connection Restriction. 

Note: When you are naming data-source connections (Step 4, page 35), 
consider choosing tenant-identifying names, such as 
Tenant1Connection or GI2_Tenant2_Oracle10g. 

Note: The concept of assigning user and group permissions in CMC to 
connections (discussed on page 50) is different from the concept of 
assigning connection restrictions to users and groups within 
Designer. Within CMC, you cannot define a connections map 
within one universe to map different data-source connections to 
defined users and/or groups as you can in Designer. 
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Figure 22: The Manage Access Restrictions Dialog Box Showing Two Restrictions

4. On the Connection tab, select the appropriate data-source connection for 
the tenant—for example, GI2_Tenant1_MSSQL. 

Figure 23 shows these selections in the Edit Restrictions dialog box. 

5. Click OK to save the restriction, close the Edit Restrictions dialog box, 
and return control to the Manage Access Restrictions dialog box. 

Figure 23: Creating a Connection Restriction for Tenant1 
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6. Repeat Steps 2 through 4 for each connection restriction that you want to 
define. 

7. Under the Available groups and users frame of the Manage Access 
Restrictions dialog box, click Add user or group to open the Select Users 
and Groups dialog box. 

8. From the Available groups and users frame, select all of the users whose 
access to this universe you want to restrict, and move them to the Selected 
groups and users frame. Click OK. 

9. One by one, assign the available restrictions that you created to the 
appropriate group and/or user. 

10. Click Ok to save your changes, and close the Manage Access Restrictions 
dialog box. 

Creating Other Types of Restrictions

There are other types of restrictions that you can set within Designer. Read 
more about restrictions in the “Managing Universes” chapter of the SAP 
BusinessObjects XI 3.1 Universe Designer guide. 

Setting Integrated Data Access 
Restrictions 

Beginning in release 8.1.4, data access restrictions are integrated with data 
access roles (this functionality is also available in 8.1.1 releases beginning with 
8.1.104). These restrictions control access to objects within the Info Mart 
database so that BO users who are members of BO groups with associated 
access restrictions see data only for appropriate contact center resource groups 
(Agent Groups or Queue Groups that are configured in the Configuration 
Layer). There are two types of these restrictions:

• Static Access Restrictions: Allow you to configure a list of objects for 
which no data appears when reports are viewed by users who are members 
of restricted groups. For example, you can use this feature to prevent group 
members from viewing data for 'system' objects (such as Queue/Queue 
Groups).

Tip: Because the Manage Access Restrictions dialog box does not 
have an Apply button, you might want to save your changes 
periodically by closing the dialog box (clicking Ok) and reopening it, 
especially if you have several restrictions to define.
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• Dynamic Access Restrictions: Allow you to restrict access to data based 
on each BO user name and attributes you configure to describe the user's 
geographical location, line of business, or organizational role. For 
example, you can use this feature to ensure that a supervisor sees data only 
from agents in specified locations, on specified teams.

Integrated data access restrictions are supported only in release 8.1.4 and in 
8.1.1 releases beginning with 8.1.104. Note that:

• In 8.1.4 deployments: default restrictions are defined (Static Access 
Restriction and Dynamic Access Restriction), together with a default 
group (Interactive Insights access restrictions) that has these two 
restrictions applied. 

• In 8.1.1 releases (8.1.104 and later): default restrictions are defined (Static 
Access Restriction and Dynamic Access Restriction), with a default 
group (Interactive Insights access restrictions) that has Static 
Access Restriction applied. 

Custom Data Access Restrictions

You can customize integrated data access restrictions by configuring the 
following Data Access Visibility (DAV) attributes, which are available on each 
object’s Annex tab:

• ORG (Organizational Role)

• GEO (Geographic Location)

• LOB (Line of Business)

You restrict access to data by defining values on the Annex tab, as follows:

• For each Person: BO login, plus one or more DAV attributes

• For each contact center group: one or more DAV attributes

As long as a user has at least one DAV attribute that matches a group, then that 
user can see data from that group. 

For example:

• Agent Group1 has the following annex value: RPT_GEO=Daly City

• Agent Group2 has the following annex value: RPT_GEO=San Francisco

• Agent SuperVisor1 has the following annex value: RPT_GEO=Daly City

• Agent SuperVisor2 has the following annex value: RPT_GEO=San Francisco

When Agent SuperVisor1 runs a report, the report contains data from Agent 
Group1, but not data from Agent Group2. The reverse is true for 
Agent_Supervisor2

Data access restrictions use a small amount of system resources, so configuring 
them can result in a slight decrease in system performance.
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Configuring Access Restrictions

You define DAV attributes using Configuration Manager, and define access 
restrictions using the Information Design Tool.

1. Using Configuration Manager, perform the following steps for each user 
(Person):

a. If it is not already present, add the RPT section.

b. Within the RPT section, add an option with:
• Option Name = BOE_USER

• Option Value = <username>

c. If they are not already present, add one or more of the following 
sections: 
• RPT_GEO
• RPT_ORG
• RPT_LOB

d. Within each of the sections you added in Step c, assign suitable 
options. For example, within the RPT_GEO section, you might add an 
option and assign it an Option Name that describes the geographical 
location of a group, such as Daly City.

2. Using Configuration Manager, perform the following steps for each 
contact center Group (Agent Groups and DN [ACD Queue] Groups):

a. If they are not already present, add one or more of the following 
sections: 
• RPT_GEO
• RPT_ORG
• RPT_LOB

b. Within each of the sections you added in Step a, assign suitable 
options. For example, within the RPT_GEO section, add an option and 
assign it an Option Name that describes the geographical location of a 
group, such as Daly City.

Note: By default, in Configuration Manager, the Annex tab is hidden. 
Open View > Options, and ensure that Show Annex tab in object 
properties is selected. 

Note: Neither Genesys Info Mart nor GI2 processes the Option 
Value for options in the [RPT_GEO], [RPT_ORG], or [RPT_LOB] 
sections, so you can leave the option value blank, and enter 
only the option name (unless the Configuration Server 
installed in your environment requires a value, as is the 
case in Configuration Server 7.6 and earlier).
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3. Using the Information Design Tool (BI 4.1) or Designer (BO XI 3.1), 
assign Access Restrictions to the relevant BO groups. 

In BO XI 3.1 Designer, you can apply only one access restriction to each 
group. If your deployment has BO XI 3.1, and you want to apply more than 
one access restriction (for example, both the default Static Access 
Restriction and Dynamic Access Restriction), you must:

a. Create two or more groups (or create one group, and for the other, use 
the default group Interactive Insights access restrictions).

b. Assign one access restriction to each group (using the default access 
restrictions, custom restrictions that you create, or a combination of the 
two).

c. Organize a Group Hierarchy, so that one group is a sub-group of the 
other. 

You can assign priorities to the access restrictions associated with each 
group, and BO applies these access restrictions starting with the 
highest-level priority within the hierarchy.

For more information about working in Genesys Configuration Manager, see 
Framework 8.1 Configuration Manager Help.

Translating the Universe, GI2 Reports, and 
BO GUI

Genesys provides installation packages of the GI2 product in more than one 
language, as does BO. The steps to install BO in other locales are described in 
the SAP BusinessObjects Enterprise XI 3.1 Installation Guide for Windows/
UNIX. To display the reports and use the universe and BO in a language other 
than English, complete the following steps:

1. Change the host’s browser locale. 

2. Install the target BO language pack(s). (Refer to “Installing language 
packs” in the SAP BusinessObjects Installation Guide.) 

3. Within CMC, change the BO product locale (see Figure 24). 
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Figure 24: CMC Preferences – Changing the Product Locale

4. If you are installing the Turkish or Russian GI2 language pack, install it 
now, and skip the remaining steps in this procedure. For all other 
languages, continue with Step 5.

5. Import XLF files of the translated universe and reports into the Business 
Objects repository. 

For each supported language, Genesys provides one translated file of the 
universe and several translated files of the GI2 reports (one translated file 
for each report) in XML Localization Interchange File Format (XLIFF)— 
for example, Contact List Effectiveness Report.xlf. Using a three-step 
process, you must identify each translation file to the BO repository: 

a. Within Translation Manager (a standalone BO application), import the 
untranslated report [a Web Intelligence document (*.wid)] and 
GI2_Universe.unv from CMS. 

b. Import each Genesys-provided XLF file into Translation Manager. 
Figure 25 shows the dialog box through which you perform the import. 

c. Save and export the results back to CMS. 

Note: Check the appropriate GI2 Language Pack Release Note to ensure 
that the release of the language pack you plan to install is 
compatible with the installed release of GI2.
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Figure 25: Translation Manager: Import from XLIFF Wizard

6. Rename the GI2 reports (to their translated equivalents) within InfoView. 

Neither within the XLF files nor within Translation Manager can the 
names of Web Intelligence documents be translated. Within InfoView, you 
must rename them manually. 

7. Finally, rerun and save each report so that the new, translated resources 
will be picked up.

You have now translated the names of universe objects (the names and 
descriptions of measures, dimensions, conditions, prompts, contexts, and 
the universe object itself) and report elements (including labels, report 
headers, variables, and user prompts) as well as the BO user interfaces.  

8. To translate custom reports and universe objects, you must use Translation 
Manager. Refer to the BusinessObjects Translation Manager help file for 
information on how to use Translation Manager. 
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Customizing Measure Definitions
Genesys supports limited customization of the following GI2 measures: 

You can redefine these measures within Designer as prescribed within each 
measure’s properties within the universe. Refer to the Genesys Interactive 
Insights 8.1 User’s Guide for information about how to customize measures. 

After you have customized measure definitions, be sure to export the universe 
back to the BO repository by following the steps on page 43. 

• In the Activity class: 
 Avg Handle Time 
 Handle Time 

• In the BA Customer class 
 % First Response Time Service 

Level 
 % First Response Time Service 

Level 80 

• In the Queue class: 
 % Accepted 
 % Accepted 80 
 Avg Handle Time 
 Handle Time 

• In the Summarized State class
 % Occupancy 
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4 Installing Genesys 
Interactive Insights
If you installed BusinessObjects (BO) software prior to installing Genesys 
Interactive Insights (GI2), follow the instructions provided in this chapter in 
order to install GI2. At your option, however, you can also install BO software, 
silently, during installation of GI2. This chapter describes this deployment 
scenario also. 

In addition, GI2 requires connection to an 8.1 Info Mart. This 
database—although not required for GI2 installation—should be regularly 
populated by a Genesys Info Mart 8.1 application. Refer to the Genesys Info 
Mart User’s Guide and Genesys Info Mart Deployment Guide for this 
information. Genesys Info Mart 8.1 must be properly configured and installed 
before GI2 runs the aggregation process. The Reporting and Analytics 
Aggregates (RAA) documentation set describes this aggregation option of 
Genesys Info Mart. 

This chapter contains the following sections: 
 Overview of the Installation Routine, page 64 
 Prerequisites, page 64 
 Backing Up Prior Universes, page 65 
 Installing GI2 on UNIX, page 65 
 Installing GI2 on Windows, page 69 
 Manually Running the GI2 Installation Script, page 72
 Manually Importing Objects and Data Elements, page 73 
 Viewing the GI2 Reports and Universe, page 77

After you have installed GI2, perform the additional steps that are described in 
Chapter 3, “Setting Up the Environment,” on page 29 to ready the universe for 
report users. 
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Overview of the Installation Routine
Beginning with the GI2 8.0 release, in lieu of automatically deploying GI2 to 
your environment and within the BO repository, when invoked, the installation 
routine offers you the option to copy the installation script and supporting files 
to a designated location for manual deployment at a later time. This option 
provides you with more control and visibility into the inner workings of the 
installation routine. 

In addition to copying the installation script and supporting files (including the 
BO installation package, if you indicate to install BO software), the routine’s 
deploy-now option: 

• Copies (to the Interactive Insights root folder) the \agg folder which holds 
RAA. 

• Imports the GI2 universe, folder, reports, connection, measure maps, and 
PDF documents into the BO repository. 

• Defines different users and groups within BO. 

• Updates the program registry on Microsoft Windows platforms. 

These same actions are performed when you manually install GI2 after 
choosing the copy-only option. 

If, for any reason, the installation exits without successfully installing GI2 or 
without importing the GI2 universe, folder, or reports, you can review the 
contents of the deploy_unv_rep.log file (which is located in the Interactive 
Insights root directory), correct the error, and rerun the deployed installation 
script. (This log file is not produced for GI2 8.1.3 or 8.1.4 releases.) Refer to 
“Application Files” on page 107for the names of the application files that are 
deployed. This file is only produced only if BO software has been installed. 

Prerequisites
You can install multiple instances of GI2 on the same host. To install GI2, the 
following prerequisites must be met: 

• BO software must be installed on the same host where GI2 will be 
installed—whether manually (prior to GI2 installation) or silently (for GI2 
8.1.0 or 8.1.1 installations only; GI2 8.1.3 and 8.1.4 do not provide a silent 
installation). Refer to Chapter 2, “Which BO Components Must Be 
Installed?,” on page 19 for additional information. 

Note: Unlike most other Genesys applications, GI2 is neither configured as 
an application within Genesys Configuration Server nor started (nor 
stopped) by using the Genesys Solution Control Interface. 
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• You must connect to the BusinessObjects Central Management Server 
(CMS) as Administrator and the BO servers must be running. 

• You must have the GI2 8.1 installation package (and the BO installation 
package for deployment of both applications). 

• Your operating-system version must comply with a version that is 
supported by BO. 

In addition, before you operate the GI2 reports, you must have access to an 
Info Mart schema that is populated by Genesys Info Mart 8.1. Refer to the 
Genesys Info Mart 8.1 Deployment Guide or the Genesys Migration Guide for 
information that pertains to configuring, installing, or upgrading these 
products. Although the installation routine does not check for this, the BO 
license that Genesys provides requires such access for use of the software. 

Backing Up Prior Universes
To preserve the customizations that you might have made to a pre-existing GI2 
universe, Genesys recommends, as a precaution, that you back up any GI2 
universes that might exist in the BO repository before you install GI2 anew; 
the installation routine might overwrite a pre-existing GI2_Universe, regardless 
of the folder in which it resides. One way to accomplish this is to export the 
universe to either:

• A BIAR (Business Intelligence Archive Repository) file (GI2 8.1.0–8.1.1) 

• An LCMBIAR file (GI2 8.1.3/8.1.4) 

and store it for safekeeping. Refer to BO documentation for instructions on 
how to export the universe to these formats. 

Installing GI2 on UNIX 

Instructions for BO XI 3.1

1. In the directory into which you copied the GI2 installation package (or 
from the Genesys Interactive Insights 8.1 DVD), locate the install.sh 
shell script. 

2. Run this script from the command line by typing: sh install.sh 

3. When prompted to do so, indicate whether to copy only the GI2 
installation files: y or n. 

Tip: If you installed BO prior to installing GI2, consider running the 
BusinessObjects Diagnostic Tool and addressing any issues 
encountered.
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If you select y, the installation routine copies the files that are needed to 
install GI2 manually to the current directory. You will have to manually 
deploy the GI2 universe and reports to the BO repository and set up groups 
and user permissions. 

If you select n, proceed to Step 4. 

4. When prompted to do so, indicate whether to deploy GI2: y or n. 

If you selected y at Step 3, select n at this step. 

5. When prompted, indicate whether to install BO software: y or n. 

If you selected y at Step 3, select n at this step. 

6. If you selected to install BO at Step 5, type the full path of the BO 
installation files; otherwise, skip to Step 8. This path cannot contain 
spaces. 

The installation routine verifies the path’s existence before you proceed to 
the next step. 

7. Type the provided license key for BO software, including the dashes. 

8. Type the destination directory of the BO installation. This path cannot 
contain spaces. Skip to Step 11 if you responded n at Step 4. 

This path represents the directory where the installation routine will install 
the application (if you selected to install BO at Step 4) or the existing 
directory where the application has already been installed. 

9. Type the CMS port, or accept the default (6400). Skip to Step 16 if you 
responded n at Step 4. 

10. When prompted, specify a password for Administrator. Genesys 
recommends that you do not leave the password null. 

11. Specify the host for the BO CMS, or accept the default, which is the name 
of the local computer. 

The host name you specify cannot contain underscores (_), periods (.), or 
slashes (/ or \). Go back to Step 9, if you responded n at Step 4. 

Note: BO software must be installed so that the GI2 universe, folder, and 
reports can be deployed to the BO repository. If you do not install 
BO at this point, you must have the location of BO software at 
hand in order to proceed past Step 8. 

Notes: This keycode is: 
• Case insensitive 
• Not dependent on the operating system platform 
• Specific to Genesys-provided BO software 

In addition, the BO XI 3.0 keycode will work for Genesys-
provided BO XI 3.1 software. 
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12. Type the port for the BO Intelligence Agent, or accept the default (6410). 

13. Type a name for the CMS database, or accept the default (BOE120). 

14. Type a name for the CMS auditing database, or accept the default 
(BOE120_AUDIT). 

15. Type the port for the CMS database, or accept the default (3306). 

16. Type the password of the CMS database administrator. Skip to Step 23, if 
you responded n at Step 4.

17. Type the user name for a CMS database nonadministrative user, or accept 
the default (sa). This user represents the CMS database owner. 

18. Type the password of the CMS database user from Step 17. 

19. Type the connection port for the Tomcat application server, or accept the 
default (8080). 

20. Type the redirect port for Tomcat, or accept the default (8443). 

21. Type the shutdown port for Tomcat, or accept the default (8005). 

22. Type the BO installation type: 1 for user, 2 for system. The system 
installation type enables the BO servers to start and stop automatically 
when the UNIX server is brought up or shut down. 

23. Type the full path of the destination directory for GI2 installation files. 
This path cannot contain spaces. 

The installation routine verifies that a valid path was entered, extracts the 
BO and/or GI2 archives using the destination directories that were 
specified in Steps 6 and 23, and loads the GI2 reports and universe into the 
BO repository. 

If the installation routine fails to connect, the installation halts. You will 
have to resume the installation manually as described on page 72. 

Finally, the installation routine generates a log file, deploy_unv_rep.log 
and exits. 

See “Application Files” on page 107 for a description of the files that are 
deployed. After successful installation, Genesys recommends that you edit the 
gi2_setenv.sh file to remove the password, if you are concerned about 
security. 

Notes: The GI2 installation presumes MySQL as the DBMS type. BO, 
however, accepts other types for this database when the software is 
deployed apart from GI2. 

Starting from Service Pack 5, BO uses SQLAnywhere as default 
CMS DBMS with default port 2638. 

Note: This installation presumes the Tomcat application server as the 
server that ties your data mart to BO. BO, however, accepts other 
application servers when BO software is deployed apart from GI2. 
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Instructions for BI 4.1

BO software must be preinstalled so that the GI2 universe, folder, and reports 
can be deployed to the BO repository. 

1. In the directory into which you copied the GI2 installation package (or 
from the Genesys Interactive Insights 8.1 DVD), locate the install.sh 
shell script. 

2. Run this script from the command line by typing: sh install.sh 

3. When prompted to do so, indicate whether to copy only the GI2 
installation files: y or n. 

If you select y, the installation routine copies the files that are needed to 
install GI2 manually to the current directory. You will have to manually 
deploy the GI2 universe and reports to the BO repository and set up groups 
and user permissions. 

If you select y, proceed to Step 9. 

4. When prompted to do so, indicate whether to deploy GI2: y or n. 

If you selected n at Step 3, select y at this step. 

5. Type the path of the BO installation. This path cannot contain spaces. 

6. Specify the host for the BO CMS, or accept the default, which is the name 
of the local computer. 

The host name you specify cannot contain underscores (_), periods (.), or 
slashes (/ or \). 

7. Type the CMS port, or accept the default (6400). 

8. Type the password for the BO Administrator. 

9. Type the full path of the destination directory for GI2 installation files. 
This path cannot contain spaces. 

The installation routine verifies that a valid path was entered, extracts GI2 
archives using the destination directories that were specified, and loads the 
GI2 reports and universe into the BO repository. 

If the installation routine fails to connect, the installation halts. You will 
have to resume the installation manually as described on page 72. 

See “Application Files” on page 107 for a description of the files that are 
deployed. After successful installation, Genesys recommends that you edit the 
gi2_setenv.sh file to remove the password, if you are concerned about 
security. 
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Installing GI2 on Windows

Instructions for BO XI 3.1

1. From the Genesys Interactive Insights 8.1 CD or image, double-click the 
setup.exe file. 

The installation routine checks the Windows registry for an existing GI2 
installation before it displays the Welcome page. 

2. At the Welcome page, click Next. 

3. At the Installation Mode page, choose one of the following options: 
 Deploy Genesys Interactive Insights 
 Copy Genesys Interactive Insights files only 

Then, click Next. 

If you selected only to copy installation files, skip to Step 11.

4. At the Select Options page, choose one or more of the following options: 
 Install BusinessObjects Enterprise (BO) XI 
 Install Interactive Insights 

Then, click Next. 

If BO is already installed on your host and you select only to install GI2, 
skip to Step 6. 

If you selected to copy GI2 files, the installation routine copies the files to 
the current folder and exits. 

5. At the BusinessObjects Enterprise Product Key page, enter the product 
keycode, and click Next. This keycode is case-insensitive and includes 
dashes. 

6. At the BusinessObjects Enterprise Central Management Server page, 
enter the password of the CMS Administrator, and click Next. 

The installation routine prepopulates default values in the Host name and 
Port fields. Change these values, if desired. The host name that you specify 
cannot contain underscores (_), periods (.), or slashes (/ or \). 

Skip to Step 11 if you selected only to install Interactive Insights at Step 4. 

7. At the BusinessObjects Enterprise Central Management Database Server 
page, enter connectivity parameters for the following fields, or accept the 
defaults, and click Next: 

Note: The installation routine forces selection of the Install Business 
Objects option, if you select to deploy GI2 and if it detects no such 
installation on the local host. 

 Database name (default: BOE120) 
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8. At the Business Objects Enterprise Configuration Parameters page, 
enter the following server parameters for the BO Intelligence Agent and 
for Tomcat, or accept the defaults, and click Next: 

9. At the Choose BusinessObjects Enterprise (BOE) XI Location page, enter 
the full path for the BO installation, and click Next. 

10. At the Choose BusinessObjects Enterprise (BOE) XI Installation 
Program Location page, enter the folder where the BO installation files 
exist, and click Next. 

11. At the Choose Destination Location page, specify where the installation 
routine is to install the GI2, or accept the default location, and click Next. 
The default location is: 

C:\Program Files\GCTI\Genesys Interactive Insights 

12. At the Ready to Install page, click Install. 

The installation routine extracts the BO and/or GI2 archives by using the 
destination directories that were specified in Steps 9 and 11; adds keys to 
the registry; loads the GI2 reports, universe, users, groups, and rights; 
scans the BO repository for existing components; generates a log file that 
reports its results; and then exits. 

13. Check the deploy_unv_rep.log file for indication of a successful GI2 
installation. The last line of the file should indicate the scan results of the 
BO repository: 

Test finished, no errors found. 

 Auditing Database name (BOE120_AUDIT) 
 Database Port (3306)
 Administrator password 
 User name (sa) 
 User password 

Note: Starting from Service Pack 5, BO uses SQLAnywhere as default 
CMS DBMS with default port 2638. 

 SIA Node name (default: name of local host)—The host name that you 
specify cannot contain underscores (_), periods (.), or slashes (/ or \). 
SIA is the Server Intelligence Agent that manages BO services and 
servers. 

 SIA Port (6410) 
 Tomcat HTTP Connection Port (8080) 
 Tomcat Redirect Port (8443) 
 Tomcat Shutdown Port (8005) 

Note: This step could take upward of an hour to complete if you opted to 
install BO (option Deploy Genesys Interactive Insights) at 
Step 3. 
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If the results of the scan yield an error, the line reads as follows: 

Test finished. There are errors, see log above. 

If the installation routine fails to deploy BO or fails to connect to CMS, the 
routine halts and logs appropriate messages. You will have to resume the 
installation manually as described below. 

See “Application Files” on page 107, for a description of the files that are 
deployed. After successful installation, Genesys recommends that you edit the 
gi2_setenv.bat file to remove the password, if you are concerned about 
security. 

Instructions for BI 4.1

1. From the Genesys Interactive Insights 8.1 CD or image, double-click the 
setup.exe file. 

The installation routine checks the Windows registry for an existing GI2 
installation before it displays the Welcome page. 

2. At the Welcome page, click Next. 

3. At the Installation Mode page, choose one of the following options: 
 Deploy Genesys Interactive Insights 
 Copy Genesys Interactive Insights files only 

Then, click Next. 

If you selected only to copy installation files, skip to Step 5.

4. At the BusinessObjects Enterprise Central Management Server page, type 
the password of the CMS Administrator, and click Next. 

The installation routine prepopulates default values in the Host name and 
Port fields. Change these values, if desired. The host name that you specify 
cannot contain underscores (_), periods (.), or slashes (/ or \). 

5. At the Choose Destination Location page, specify where the installation 
routine is to install GI2, or accept the default location, and click Next. The 
default location is: 

C:\Program Files (x86)\GCTI\Genesys Interactive Insights 

6. At the Ready to Install page, click Install. 

The installation routine extracts the GI2 archives from the destination 
directory that was specified Step 5; adds keys to the registry; loads the GI2 
reports, universe, users, groups, and rights; scans the BO repository for 
existing components; and then exits. 

See “Application Files” on page 107, for a description of the files that are 
deployed. After successful installation, Genesys recommends that you edit the 
gi2_setenv.bat file to remove the password, if you are concerned about 
security. 
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Manually Running the GI2 Installation 
Script

You can use the files that are deployed by the installation routine to import the 
GI2 universe, folder, reports, users, groups, and rights. Manually running the 
installation might be necessary if you: 

• Want to deploy the universe and reports to a different BO environment. 

• Selected the copy-files-only option from the Genesys Installation Wizard. 

• Want to reimport the universe, folder, and/or reports into your 
environment. 

• The installation of GI2 was unsuccessful using the Genesys Installation 
Wizard. If so: 

a. Verify that the prerequisites, which are listed on page 64, are met. 
b. Locate the error:

 For Release 8.1.0/8.1.1, see the log file (deploy_unv_rep.log). This 
file might indicate where the installation routine halted. 

 For Release 8.1.3/8.1.4, check for errors using the Central 
Management Console (Promotion Management -> Promotions Jobs 
-> 8.1.3 (or 8.1.4).

c. Correct the error. 

If the Genesys Installation Wizard for Interactive Insights was unable to 
access CMS, you might have specified incorrect connectivity parameters. 
Open either gi2_setenv.bat (on Windows platforms) or gi2_setenv.sh (on 
UNIX platforms), set the correct parameters, and save the file. You can 
retrieve the port number from the Central Configuration Manager by 
following the steps on page 21. 

To run the installation scripts manually on Windows platforms, from the 
Interactive Insights folder: 

• To deploy the GI2 universe, reports, users, user groups, and permissions, 
run the gi2_deploy_unv_rep.bat batch script. 

• To scan the BO repository in order to confirm that its contents match those 
of the insights.biar file, run gi2_deploy_sum.bat. (GI2 8.1.0–8.1.1 only) 

On UNIX platforms, run the corresponding shell scripts to perform the same 
actions. 

When finished, check the log file (deploy_unv_rep.log) for errors. (This log 
file is not produced for GI2 8.1.3 or 8.1.4 releases.) After successful 
installation, Genesys recommends that you edit the gi2_setenv.bat file to 
remove the password, if you are concerned about security. 

Note: Before re-importation, delete the GI2 universe, folder, connection, 
user groups, and default users (that is, perform Step 3 on page 104). 
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Manually Importing Objects and Data 
Elements

The GI2 universe holds the needed business objects and data elements for 
running the GI2 reports. These data elements include classes, dimensions, 
measures, and conditions, as well as the reports themselves. Please refer to the 
Genesys Interactive Insights 8.1 Universe Guide for descriptions of universe 
elements. 

The installation routine automatically imports the GI2 universe, folders, 
reports, users, groups, and rights into your BO environment. If, however, your 
installation does not finish; you delete the universe from the Central 
Management Console in error; you want to redeploy the same universe, 
reports, and folders to your existing environment; or you want to deploy the 
universe, reports, folders, users, groups, and rights to more than one 
environment, you must invoke and complete the pages of the BusinessObjects 
Import Wizard for universe elements to be available to GI2 users. 

Operating the Import Wizard

This section describes how to manually import the GI2 universe, folders, 
reports, users, groups, and rights into BO XI 3.1 using the Import Wizard, 
which is part of the BO XI 3.1 suite for Microsoft Windows platforms. 

If you have BI 4.1, perform these steps using the Promotion Management tool, 
available through the Central Management Console (CMC), which is described 
in BO documentation. Also, in BI 4.1, you can optionally migrate your 
universe from UNV to UNX using the steps described in “Migrating Custom 
Universe and Reports (for 8.1.3 and later)” on page 93.

1. From the Windows Start menu, invoke the Business Objects Import 
Wizard.

2. At the Welcome page, click Next. 

3. At the Source environment page, from the Source drop-down box, select 
Business Intelligence Archive Resource (BIAR) File. 

4. To the right of the BIAR file field, click the button to navigate to the 
insights.biar file that was deployed during GI2 installation. Select the 
file, and click Next. 

5. On the Destination environment page, in the appropriate fields, specify the 
name of your Central Management Server (CMS), administrator login, and 
password, and then click Next. 

The Import Wizard checks that it can connect to CMS, which should 
include the connection port if it is anything other than the default—for 
example, HOST:6402. 
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6. For the 8.1.0 and 8.1.1 releases, at the Select objects to import page that 
is shown in Figure 26, select, at minimum, the following objects to import, 
and click Next: 
 Import users and users groups, with the following subcategories 

checked: 
 Import application rights 
 Import root folder rights 

 Import folders and objects 
 Import universes 
 Import custom access levels 

Figure 26: Cutaway of the Select Objects to Import Page of the Import Wizard

Note: For 8.1.3/8.1.4, you must use the Promotion Management tool, 
available through the Central Management Console (CMC), to 
import the insights.lcmbiar file. Refer to BO documentation for 
information on how to use this tool. 
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7. At the Import scenario page, select the following, and click Next: 

Update the destination object. In case of name conflict, rename it 

8. At the Incremental import page, determine which objects and object rights 
should be overwritten, and click Next. Selections on this page are 
meaningless if you are importing the universe for the first time or if you 
are importing the universe to a new environment. 

9. At the Users and groups page, select to import all groups and users, and 
click Next. 

10. At the Custom Access Levels page, select to import all access levels, and 
click Next. 

11. At the Folders and objects page, select the Interactive Insights root 
folder, and click Next. If you do not want to import all of the GI2 reports or 
documentation, open this folder and the appropriate release subfolder, and 
clear one or more of the following boxes: 

12. At the Select application folders and objects page, click Next. 

13. At the Import options for universes and connections page, select the 
following option, and click Next: 

Import all universes and all connection objects 

14. At the Import options for publications page, select the following option, 
and click Next: 

Do not import recipients 

15. At the A note on importing reports page, click Next. 

16. On the Ready to import page, the Import Wizard summarizes the objects 
that it will import according to your selections. Click Back to change any of 
your selections, or click Finish to start the import operation. 

17. When the import completes, click Done. 

Note: The next pages of the Import Wizard depend on the selections that 
you make on the Select objects to import page. You can, in fact, 
select all objects without adversely affecting the import of GI2 
elements. The following steps pertain to the minimum selections 
that are required to import GI2. 

 Agents 
 Business Results 
 Details 

 Documentation 
 Outbound Contact 
 Queues 

Note: You cannot selectively indicate which elements of the universe to 
import. 
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Universe Contents

If you have imported the GI2 universe successfully, your BO environment will 
contain the following: 

• Depending on your 8.1 release, either three, four, or five groups: 
 Interactive Insights report developers, Interactive Insights 

report editors, and Interactive Insights report viewers (for the 
GI2 8.0–8.1.1 releases) 

 Interactive Insights report basic (GI2 8.1.102 and later), and 
Interactive Insights access restrictions (GI2 8.1.4 and later, and 
8.1.1 releases beginning with 8.1.104)

• Depending on your 8.1 release, three or four users—Developer, Editor, 
Viewer, Basic (GI2 8.1.3 and later). 

• Ten folders: 
 Interactive Insights and a numbered release folder, in both 

InfoView/LaunchPad and CMC, and the following subfolders: 

• Depending on your 8.1 release, either three or four custom access levels: 
 Interactive Insights report developer access level 
 Interactive Insights report editor access level 
 Interactive Insights report viewer access level 
 Interactive Insights report basic access level (8.1.102 and later) 

• Two default access restrictions:
 Static Access Restrictions 
 Dynamic Access Restrictions

• Fifty-five objects: 
 Forty-one reports in the Agents, Business Results, Details, Outbound 

Contact, and Queues folders 
 One PDF document: the Genesys Interactive Insights 8.1 Universe 

Guide. (The Genesys Interactive Insights 8.1 User’s Guide is now 
available on the Genesys documentation website at the following URL: 
http://docs.genesys.com/Documentation/GI2/8.1.4/UG/)

 Ten measure maps (that illustrate the relationships among measures) 
 One universe—GI2_Universe 
 One connection—GI2_GIM_DB 

Refer to the Genesys Interactive Insights 8.1 Universe Guide for a 
complete listing and descriptions of these reports. 

The connection object is irrelevant to your environment, and you can safely 
ignore it. You can invoke the BusinessObjects Central Management Console to 
verify that these elements have been deployed (under Connections, Folders, 

 Agents
 Business Results
 Details

 Documentation
 Outbound Contact
 Queues
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Access Levels, and Universes, and Users and Groups). The BIAR file also 
contains objects (such as measures, dimensions, and filters) which are 
imported using the Import Wizard, but the deployment of these elements is not 
reported on the wizard’s summary page. The section below, “Viewing the GI2 
Reports and Universe”, describes yet another way to verify the import. 

Refer to BO Using the Import Wizard help file for more information about how 
to operate this utility. Refer to the "Promotion Management" chapter in the 
relevant Business Intelligence Platform Administrator Guide for information 
on how to use Promotion Management. 

Viewing the GI2 Reports and Universe
When you have successfully installed GI2, you can view the GI2 universe in 
Universe Designer and the GI2 reports in InfoView to confirm that all you 
selected during installation is present. Keep in mind, however, that additional 
setup is required to actively use the report and universe elements. The 
additional steps for setting up the environment are described in Chapter 3 
beginning on page 29. 

Viewing the Universe

Figure 27 shows a cutaway of the GI2 universe in Universe Designer. (In BO 
Business Intelligence Platform, this tool is called the Information Design 
Tool.) 
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Figure 27: The GI2 Universe in Universe Designer (BO XI 3.1) 

Refer to BO documentation to learn about the Universe Designer interface and 
to how to use this software. 

Viewing the GI2 Reports

Figure 28 shows the Interactive Insights root folder, its subfolders, and some of 
the queue-based GI2 reports in InfoView when expanded. The Documentation 
folder contains the Genesys Interactive Insights 8.1 Universe Guide, the 
Genesys Interactive Insights 8.1 User’s Guide, and several maps that illustrate 
relationships between measures. If you manually imported the universe, the 
objects provided within the report subfolders will be dependent on the 
selections you made (Step 11 on page 75) during importation; otherwise, if the 
installation routine imported the universe and reports, all of the reports will be 
imported to the repository. 
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Figure 28: The GI2 Reports in InfoView 

You can access GI2 reports using InfoView and Web Intelligence (BO XI 3.1 
deployments) or BI Launch Pad (BI 4.1 deployments). Refer to BO 
documentation for information about how to use these tools. 

GI2 Versioning

Both the GI2 universe and all reports are tagged with a version number that is 
stored inside the universe and within each report. Such labeling makes it easy 
to identify which GI2 version of a report and which version of the universe you 

Note: A release-specific subfolder of the Interactive Insights root folder 
houses the report and documentation subfolders. For the initial 7.6.2 
release, for example, this folder is aptly named 7.6.2. This folder 
structure enables you to maintain the customizations that you may have 
applied to previous GI2 universes. Text references and screen shots 
depicted throughout this documentation set, however, may either omit 
the subfolder containing the release number or the release number 
shown may differ from your release of GI2. 
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have, in the event that you initiate requests to Genesys Customer Care or have 
correspondence with other Genesys departments. This versioning might be 
further useful to your universe and report designers in distinguishing reports 
from other GI2 releases, especially because the 7.6.2 release enables their co-
existence. 

Determining the Version of the Universe 

The GI2 universe defines the GI2_UNIVERSE_VERSION parameter to identify the 
version of the universe. This version-number parameter, which is shown in 
Figure 29 on page 80, is accessed within Universe Designer from the File > 
Parameters menu. Genesys recommends that you not change its value. 

Figure 29: Universe Parameters 

Determining the Version of a Report

Stored on the Description tab of each GI2 report is a text string that represents 
the GI2 version that is associated with the report. This version number is found 
after the descriptions of the measures that are used within the report (see 
Figure 30 on page 81). Genesys recommends that you not change its value. 

Note: The version number that is shown in the figure might not match your 
version of the GI2 universe. 
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Figure 30: Report Version Is Visible on the Description Tab of the Report 

Note: The version number that is shown in the figure might not match your 
version of the report. 
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5 Accessing Genesys 
Interactive Insights 
Components
You can access Genesys Interactive Insights (GI2) reports using InfoView and 
Web Intelligence (BO XI 3.1 deployments) or Business Intelligence (BI) 
Launch Pad (BI 4.1 deployments). You access the GI2 Universe through 
Designer (BO XI 3.1 deployments) or the Information Design Tool (BI 4.1 
deployments). The same is true for localized versions of the GI2 universe and 
reports; however, you must first import localized GI2 elements using 
Translation Manager. (This procedure is described in the section beginning on 
page 59.) This chapter describes how to access each of these applications: 
 Checking Web Server Status, page 83 
 Accessing the Central Management Console, page 84
 Accessing InfoView/BI LaunchPad, page 84 
 Accessing Web Intelligence, page 86 
 Accessing Designer/Information Design Tool, page 87 
 Accessing Translation Manager, page 87 

Refer to the BusinessObjects documentation set for information about how to 
use these applications. 

Checking Web Server Status 
The Tomcat, or other Web server, must be running in order to use the Central 
Management Console (CMC), InfoView, and Web Intelligence applications. If 
you find that you cannot start these applications, within the Central 
Configuration Manager (CCM), check whether the web server is running. 
Figure 31, for example, shows a downed Tomcat server. Right-click the name 
of the server to restart it. 
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CCM is accessible only from Microsoft Windows platforms. To open CCM, at 
the Start menu, select Central Configuration Manager from the program 
folder where BusinessObjects is deployed. The default location of this folder 
is: 

Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise 

Figure 31: Checking Web Server Status using Central Configuration Manager

Accessing the Central Management 
Console

BusinessObjects supports use of the Central Management Console in several 
browsers, including Microsoft Internet Explorer and Firefox. You will need the 
name of the Web server that has been established by your administrator to start 
this application or the complete URL if your administrator configures other 
than the default parameters and path. Also, you will need to know the 
connectivity parameters of the account authorized to use CMC. The default 
path of this application is the following: 

BO XI 3.1:  http://webserver:8080/CmcApp/logon.faces 

BI 4.1:   http://webserver:8080/BOE/CMC 

Refer to the “Getting Started” chapter in the SAP BusinessObjects Enterprise 
Central Management Console User's Guide for additional information. 

Accessing InfoView/BI LaunchPad
Within the SAP BusinessObjects Enterprise XI 3.1 suite, the user interface for 
accessing, managing, and running the GI2 reports is called InfoView. In SAP 
BusinessObjects Business Intelligence Platform (BI) 4.1, this application is 
called the BI Launch Pad. 
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Both InfoView and BI Launch Pad are supported for use in several browsers, 
including Microsoft Internet Explorer and Firefox. You must have the name of 
the Web server that has been established by your administrator to start this 
application, or the complete URL if your administrator configures other than 
the default parameters and path. Also, you must have user credentials. 

The default paths are: 

BO XI 3.1:  http://webserver:8080/InfoViewApp/logon.jsp 

BI 4.1:  http://webserver:8080/BOE/BI 

Figure 32 shows the initial login screen of the BI Launch Pad.

Figure 32: BI Launch Pad
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In BI Launch Pad, you can access reports by expanding Documents > Folders > 
Public Folders > Interactive Insights, and then choosing the installed 
release, as shown in Figure 33.

Figure 33: Accessing Reports in BI Launch Pad

For additional information, see the “Getting Started” chapter in the SAP 
BusinessObjects Enterprise XI 3.1 InfoView User’s Guide or “BI Content 
Administration” in the Business Intelligence Platform User Guide. 

Accessing Web Intelligence
Web Intelligence is invoked when you select to run, view, or modify a report 
during an InfoView session. In addition to the functionality that is provided by 
InfoView, Web Intelligence enables you to drill up/down, respond to user 
prompts, and edit queries. Refer to Building Reports with the SAP 
BusinessObjects Web Intelligence HTML Report Panel or the Building Reports 
with SAP BusinessObjects Web Intelligence Rich Client for additional 
information. 



Deployment Guide 87

Chapter 5: Accessing Genesys Interactive Insights Components Accessing Designer/Information Design Tool

Accessing Designer/
Information Design Tool

Within the BO XI 3.1 suite, the user interface for viewing the definitions of 
universe elements, customizing measures, and creating and assigning Info 
Mart connections for report users is called Designer. In BI 4.1, this application 
is called the Information Design Tool. 

To open these this tool on Windows platforms, from the Start menu, select 
Designer or Information Design Tool in the program folder from which 
BusinessObjects was deployed. The default location of this folder is the 
following: 

BO XI 3.1:  Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise 

BI 4.1:  Programs > SAP Business Intelligence > SAP BusinessObjects BI 
platform 4 Client Tools 

Refer to the “Doing Basic Operations” chapter in the SAP BusinessObjects XI 
3.1 Universe Designer or the Information Design Tool User Guide for 
information on how to use these applications. 

Accessing Translation Manager
Use Translation Manager to manage the localization of universes and their 
Web Intelligence documents and prompts. You open Translation Manager on 
Windows platforms. From the Start menu, select Translation Manager or 
Translation Management Tool in the program folder in which BusinessObjects 
was deployed. The default location of this folder is: 

BO XI 3.1:  Programs > BusinessObjects XI 3.1 > BusinessObjects Enterprise 

BI 4.1:  Programs > SAP Business Intelligence > SAP BusinessObjects BI 
platform 4 Client Tools 

Refer to the Translation Manager Guide for information on how to use this 
application. (Access this document by clicking F1 within the utility.) 
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6 Migrating Genesys 
Interactive Insights
In the 8.1.0 and 8.1.1 releases, the scope of migrating Genesys Interactive 
Insights (GI2) includes migration of custom reports that were created in a prior 
GI2 release and migration of the 7.6 aggregate tables to 8.1. The tool for the 
latter is described in the Genesys Migration Guide. 

This release does not support migration to release 8.1.3 or 8.1.4, or the 
migration or upgrade of the GI2 universe itself—to use the latest universe, you 
must install it anew. As with all 7.6.2 and higher releases, the latest release also 
supports the co-existence of different releases of universes and reports within 
the same BusinessObjects (BO) repository. 

You do not need to uninstall or reinstall BO software. Nor must you uninstall 
the prior instance of GI2. Migrated reports must employ the supported 
measures or their supported alternate definitions and these measures must still 
be supported within the current release. 

This chapter includes the following sections: 
 Interoperability of Software Components, page 89 
 Summary of GI2_Universe Changes, page 91 
 Organizing BO Folders, page 91 
 Migrating Custom Universe and Reports (for 8.1.3 and later), page 93
 Linking the Most Recent Universe to Custom Reports (for 8.1.1), page 99 

Interoperability of Software Components
GI2 comprises many components; all of them should be in sync, for optimal 
report operation. Table 3 on page 90 shows the mix of the minimum required 
versions of each software component for complete functionality of all of the 
reports that were offered since the initial GI2 7.6 release. 
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Table 3: Software Versions of GI2 Components

GI2 
Release

BO
Release

Genesys Info Mart 
Release (Schema) 

RAA 
Release

7.6.0 3.0 (12.0) 7.6.001.07 (7.6.000.09) N/A

7.6.001 3.0 + Hot Fix (12.0) 7.6.001.07 (7.6.000.09) N/A

7.6.1 3.1 (12.1.0.882) 7.6.003.05 (7.6.000.09) N/A

7.6.2 3.1 (12.1.0.882) 
Fix Pack (FP) 1.8

7.6.005.11 (7.6.005.00) N/A

8.0.000.32 3.1 (12.3.0.601) 
Service Pack (SP) 3 

8.0.000.73 (8.0.000.72) 8.0.000.32 

8.0.001.03 3.1 (12.3.0.601) SP3 8.0.001.05 (8.0.001.02) 8.0.001.03 

8.0.001.06 3.1 (12.3.0.601) SP3 8.0.001.05 (8.0.001.04) 8.0.001.06 

8.0.100.05 3.1 (12.3.0.601) SP3 8.0.100.05 (8.0.100.02) 8.0.100.05

8.1.000.12 3.1 (12.3.0.601) SP3 8.1.000.25 (8.1.000.01) 8.1.000.12 

8.1.001.02 3.1 (12.3.0.601) SP3 8.1.000.25 (8.1.000.01) 8.1.001.02 

8.1.100.19 3.1 (12.5.0.1190) SP5 8.1.101.05 (8.1.101.05) 8.1.100.19 

8.1.100.30 3.1 (12.5.0.1190) SP5 8.1.102.02 (8.1.102.01) 8.1.100.30 

8.1.100.31 3.1 (12.5.0.1190) SP5 8.1.103.03 (8.1.103.01) 8.1.100.31  

8.1.101.05 3.1 (12.5.0.1190) SP5 8.1.103.03 (8.1.103.01) 8.1.100.31

8.1.102.02 3.1 (12.6.0.1596) SP6 8.1.103.03 (8.1.103.01) 8.1.100.31

8.1.103.03 3.1 (12.6.0.1596) SP6 8.1.103.03 (8.1.103.01) 8.1.100.31

8.1.104.01 3.1 (12.7.0.1983) SP7 8.1.103.03 (8.1.103.01) 8.1.104.01

8.1.300.03 Platform 4.1 
(14.1.2.1121) SP2

8.1.103.03 (8.1.103.01) 8.1.103.01 

8.1.400.17 Platform 4.1 
(14.1.2.1121) SP2

8.1.400.14 (8.1.400.14) 8.1.400.27
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Summary of GI2_Universe Changes 
Some universe additions were made for the 8.1.x releases to support new 
columns in a few of the existing and the new Interaction Volume Service Type 
Trend report. The Queue and Business Attribute classes were reorganized to 
add several consult measures and to separate them from nonconsult measures 
in different subclasses. Queue-type details were added to queue dimensions to 
identify the type of queue that performed the processing. Warm consult 
measures were added to the Activity class. The Ready measure was added to 
the Summarized State class. Revenue and Satisfaction measures were added to 
the Agent Contact and Handling Attempt classes. New threshold measures 
were added; former threshold measures were renamed with an “_80” suffix. 
Threaded and unique measures were added. Several call-progress detection 
measures were added to the Contact Attempt class. Refer to the Genesys 
Interactive Insights 8.1 Universe Guide for a complete listing and definitions 
of all measures.

Given that the universe is continuously evolving, the custom reports that you 
create by using one release of GI2 might yield different results if you run these 
reports with a different release of the GI2 universe. You should confirm that all 
of the measures in your custom reports are still supported in the latest release 
of the universe. Because the name of a measure includes the class to which it 
belongs, this includes confirmation of class existence.

Organizing BO Folders
Beginning with release 7.6.2, GI2 supports the co-existence of multiple 
releases of the GI2 universes and reports within the BO repository. Both are 
stored in release-specific subfolders of the Interactive Insights root folder. 
Prior to 7.6.2, the GI2 universe was stored in the Universes root folder of the 
BO repository and the reports were stored in the Interactive Insights root 
folder. If you are not installing GI2 for the first time and you want to maintain 
more than the current GI2 universe and reports, then, for better organization, 
Genesys recommends that you restructure Central Management Console 
(CMC) folders to relocate prior 7.6 universes and reports into release-specific 
subfolders. 

Reorganizing Report Folders

You use CMC to create and relocate report folders. For instance, to reorganize 
the report folders for the 7.6.1 release:

1. Open CMC and select Folders. 

2. Navigate to the Interactive Insights root folder and create a new subfolder 
that is named 7.6.1. 

Note: The aforementioned name is only a suggestion. 
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3. Select the Agents folder and relocate it under the 7.6.1 folder: 

a. Right-click the folder, and then select Organize > Move To. 
b. Navigate to the 7.6.1 folder, move it to the Destinations box, and 

click Move. 

4. Repeat Step 3 for the Business Results, Documentation, and Queues 
folders. 

5. If your repository holds reports from the initial 7.6.0 release, repeat Steps 2 
through 4 to organize the reports that are offered with this release. 

6. Back up your changes by exporting the repository—for example, to a 
BIAR file. 

Figure 34 shows one suggestion for the reorganization of report folders.

Figure 34: Reorganizing Report Folders into Release-Specific Subfolders

Reorganizing Universe Folders

To reorganize the universe folders for the 7.6.1 release:

1. Open CMC, and select Universes. 

2. Navigate to the Interactive Insights folder, and create a new subfolder (that 
is named, for example, 7.6.1). 

3. Select GI2_Universe at the root level and relocate it under the 7.6.1 folder: 

a. Right-click the universe, and then select Organize > Move To. 
b. Navigate to the 7.6.1 folder, move it to the Destinations box, and 

click Move. 
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4. Back up your changes by exporting the repository—for example, to a 
BIAR file. 

Figure 35 shows one suggestion for the reorganization of universe folders. 

Figure 35: Reorganizing Universe Folders into Release-Specific Subfolders

Migrating Custom Universe and Reports 
(for 8.1.3 and later)

GI2 release 8.1.3 introduced SAP BusinessObjects Business Intelligence 
Platform (BI) 4.1. In release 8.1.3 or 8.1.4 deployments, you can optionally 
migrate the UNV universe and reports (BO XI 3.1 universe format) to the 
UNX universe (BI 4.1 universe format). Use the information in this section to 
migrate the universe and reports, or to make necessary configuration changes if 
you do not migrate the universe and reports:

• “Migrating Your BO XI 3.1 Deployment to BI 4.1”

• “Migrating Your BO XI 3.1 Deployment to BI 4.1 Without Converting the 
Universe from UNV to UNX” on page 96
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Migrating Your BO XI 3.1 Deployment to BI 4.1

Use the information in this section to migrate your custom universe and reports 
from BO XI 3.1 (UNV Universe) to BI 4.1 platform (UNX Universe).

Before you begin, ensure that the following servers on the source and 
destination deployments are shut down, to avoid inconsistent states in your 
new BI 4.1 deployment:

• All of the servers in the source deployment, except the Central 
Management Server (CMS) and the File Repository Server (FRS).

• All of the servers (including all of the Job Servers) in the destination 
deployment, except the CMS, FRS, and the Report Application Server (if 
you plan to upgrade Crystal Reports documents).

To migrate your SAP BusinessObjects Enterprise deployment, perform the 
following steps:

1. Launch the Upgrade management tool: Start > Programs > SAP Business 
Intelligence > SAP BusinessObjects BI platform 4 > Upgrade 

management tool.

Follow the steps that appear in the Upgrade management tool, which 
guides you through the process of exporting BI content (user accounts, 
groups, folders, reports, universes, security, and other objects) and 
upgrading BI.

For more information about the upgrade process, see the SAP 
BusinessObjects Enterprise Upgrade Guide. 

2. Check the UNV universe for cases where a class and dimension (measure) 
have the same name (for example, in the GI2 Universe, there is both a class 
and a dimension named Queue). Open the UNV universe using the Universe 
Design tool, and rename each dimension that has such a naming conflict. 
For example, in the case of the “Queue” dimension, change the name to 
“Queue-”. 

Note that, if you attempt to convert the universe with a class and dimension 
(measure) having the same name, the following error appears during the 
conversion of UNV to UNX: Error converting universe. Ambiguous 
object path for 'Queue\Queue'... 

3. After the Upgrade management tool exports the content from BO XI 3.1 to 
BI 4.1, use the Information Design Tool to convert the custom universe 
from UNV to UNX format manually. Run the convert procedure with the 
prompt convert option.

4. For each dimension that you renamed in Step 2, restore the original names 
(for example, rename the dimension “Queue-” to “Queue”). Save and 
publish the UNX universe to the server.
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5. Perform the following steps to update the UNX universe (GI2_Universe 
standard objects are shown as examples):

a. Update all conditions to use the new @Prompt() function syntax, except 
…TimeRange conditions from the Detail class. 

The @Prompt function has a new alternative syntax to take advantage of 
named parameters. For conditions that use the @Variable() function, 
replace the @Variable() function with the @Prompt() function.

For example, change @Variable(“Agent Group:”) to “@Prompt(Agent 
Group”). For more information, see the related topic in the Information 
Design Tool User Guide.

b. Update all …TimeRange conditions from the Detail class to use the new 
format of the default values and new data type in @Prompt() function. 
For example: 
@Prompt('Start Time:','DT',,Mono,Free,Persistent,{'Mar 1, 2013 
12:00:00 AM'},User:2)

c. If the custom universe uses REPLACE_COMMA_BY_CONCAT parameter, you 
must update the SQL definitions for objects that use the “,” sign as a 
concatenation operand. Use the standard BO function {fn concat()} 
instead of the comma. For example:
{fn concat({fn concat(@Select(Outbound Contact\Contact 
Attempt\Campaign),'@')},@Select(Outbound Contact\Contact 
Attempt\Campaign Group\Group Name))}

Update the following GI2 universe objects:
— Agent\Activity\State and Reason\Reason Code (in versions older 

than 8.1.103.03)
— Detail\Agent Detail\State\Reason Code (in versions older than 

8.1.103.03)
— Detail\Agent Detail\Ixn State\State (in versions older than 

8.1.103.03)
— Outbound Contact\Contact Attempt\Campaign Group

— Outbound Contact\Agent Contact\Campaign Group\Group Name

6. To reassign Web Intelligence documents to the new UNX universe, open 
the Change Source dialog box, check mapping for all objects, and remap 
any that are not correct. 

7. If you have Web Intelligence documents that use merged dimensions in a 
section, table, or in the other report elements, recreate the merged 
dimensions and assign them in appropriate report elements.

8. For any parameterized URLs that have the OpenDocument syntax, update 
them to use the new syntax. This is important if those URLs are used in 
Web Intelligence documents.

Parameter references, including syntax and usage examples, are provided 
for each OpenDocument URL parameter in the Viewing Documents Using 
OpenDocument SAP Product Guide.
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Format the URLs as follows:

="<a href=\"../../../../../OpenDocument/opendoc/

openDocument.jsp?...

Note that the sWindow parameter is obsolete in BO XI 3.1 and later. Instead, 
use the HTML anchor’s target attribute or an equivalent. For example: <a 
href="..." target="_blank">...</a>

9. Verify Custom Access Levels by editing the migrated Custom Access 
Levels in the CMC. Check the Name column for levels that have Unknown 
Rights instead of the description that was given in BO XI 3.1 (for 
example, Interactive Insights report basic/viewer/editor/developer 
access level). 

This right change occurs because InfoView is no longer available, and BI 
Launchpad does not offer the same rights that are available in the 
application area of the CMC. Some of the Web Intelligence viewers and 
functionality have changed, and the related rights do not exist or are no 
longer relevant. 

You can achieve the same level of restrictions that these Custom Access 
Levels had in BO XI 3.1 by combining existing rights available in the 
CMC. For more information, see the SAP white paper How Security Rights 
are migrated between 3.x and 4.0.3.

Migrating Your BO XI 3.1 Deployment to BI 4.1 Without 
Converting the Universe from UNV to UNX

Use the information in this section to migrate your custom universe and reports 
from BO XI 3.1 to BI 4.1 platform, without converting your Universe from 
UNV to UNX. 

Before you begin, ensure that the following servers on the source and 
destination deployments are shut down, to avoid inconsistent states in your 
new BI 4.1 deployment:

• All of the servers in the source deployment, except the CMS and the FRS.

• All of the servers (including all of the Job Servers) in the destination 
deployment, except the CMS, FRS, and the Report Application Server (if 
you plan to upgrade Crystal Reports documents).

To migrate your SAP BusinessObjects Enterprise deployment, perform the 
following steps:

1. Launch the Upgrade management tool: Start > Programs > SAP Business 
Intelligence > SAP BusinessObjects BI platform 4 > Upgrade 

management tool.

Follow the steps that appear in the Upgrade management tool, which 
guides you through the process of exporting BI content (user accounts, 
groups, folders, reports, universes, security, and other objects) and 
upgrading BI.
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For more information about the upgrade process, see the SAP 
BusinessObjects Enterprise Upgrade Guide. 

2. For any parameterized URLs that have the OpenDocument syntax, update 
them to use the new syntax. This is important if those URLs are used in 
Web Intelligence documents.

Parameter references, including syntax and usage examples, are provided 
for each OpenDocument URL parameter in the Viewing Documents Using 
OpenDocument SAP Product Guide.

Format the URLs as follows:
="<a href=\"../../../../../OpenDocument/opendoc/
openDocument.jsp?...

Note that the sWindow parameter is obsolete in BO XI 3.1 and later. Instead, 
use the HTML anchor's target attribute or an equivalent. For example: <a 
href="..." target="_blank">...</a>

3. Check reports for cases where drilling up from an original dimension to the 
next aggregation level causes report sections to be populated by the text 
#MULTIVALUE, instead of by the expected data. This occurs because the 
layout of some reports define section breaks that are appropriate only to the 
original aggregation level (dimension) designed for the report. These 
section breaks do not accommodate drilling operations. 

For example, the Agent Interval Based Report has a section break on Agent 
Name. As a result, drilling up to Agent Group does not redefine the section 
break to occur on agent groups, and reports for drilled aggregation levels 
display the result #MULTIVALUE.

To prevent this, disable drill up/down operations from the section 
dimension of the report. For example, to disable drilling for Agent Interval 
Based Report:

a. Open the report in design mode. 

b. Change the following formulas in the Agent Name section:

4. The GI2 reports Abandon Delay Report and Speed of Accept (hours/
seconds) Report have incorrect legend colors, and graphical elements are 
incorrectly positioned on the chart.

To prevent this, make the following changes:

a. Assign TimeRangeKey dimension to the Category Axis.

b. In the Category Axis, under Layout, turn off Show Labels.

c. In the Category Axis, change the Custom Title value to:
(=" ST 1 ST 2 ST 3 ST 4 ST 5 ST 6 ST 7 ST 8 ST 9 ST 10")

From To

=NameOf([Session Query].[Agent 
Name])

=NameOf([Session Query].[Agent 
Name])+""

=[Agent Name] =[Agent Name]+""
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5. Verify Custom Access Levels by editing the migrated Custom Access 
Levels in the CMC. Check the Name column for levels that have Unknown 
Rights instead of the description that was given in BO XI 3.1 (for example, 
Interactive Insights report basic/viewer/editor/developer access 
level). 

This right change occurs because InfoView is no longer available, and BI 
Launchpad does not offer the same rights that are available in the 
application area of the CMC. Some of the Web Intelligence viewers and 
functionality have changed, and the related rights do not exist or are no 
longer relevant. 

You can achieve the same level of restrictions that these Custom Access 
Levels had in BO XI 3.1 by combining existing rights available in the 
CMC. For more information, see the SAP white paper How Security Rights 
are migrated between 3.x and 4.0.3.

After Migration from BO XI 3.1 to BI 4.1

For any issues you encounter after migration, see the Known Issues and 
Recommendations section in the Genesys Interactive Insights 8.1.x Release 
Note. 
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Linking the Most Recent Universe to 
Custom Reports (for 8.1.1)

The procedure for migrating custom reports that were designed by using a 
prior release of GI2 to the 8.x release consists of two-steps: 

• Rename report measures to the names that were used in the latest universe. 

• Link the report to the latest universe. 

Running the upgrade utility accomplishes the first step. This utility is described 
in the chapter of the Genesys Interactive Insights 8.1 User’s Guide that 
describes upgrading GI2 Reports. The second step requires that you manually 
link the associated universe for each report to point to the new universe. This is 
accomplished within Web Intelligence and is described in the following 
procedure. 

1. Open your custom report in Edit mode. 

2. Click Edit Query, and then select the Properties tab, as shown in 
Figure 36: 

Figure 36: Properties Tab of a Report’s Main Query

3. To the right of the universe name, click the three dots to open the Universe 
dialog box, which is shown in Figure 37. 
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Figure 37: Universe Dialog Box

4. Select the desired universe from the appropriate release-specific subfolder 
of GI2. 

5. At the Change Source dialog box, shown in Figure 38, click OK to have 
BusinessObjects map target objects to source objects. 

Under some circumstances, you will need to map a measure that existed 
from a prior release to a completely new measure in the current release. 
Such is the case, for example, for customizations that you might have made 
to the Agent Inbound Call Handling VQ Report that was released with the 
initial GI2 7.6.0 release. The ...by VQ measures were subsequently 
discontinued and replaced by other measures. Measure descriptions in the 

Note: Each release of GI2 names the GI2 universe identically: 
GI2_Universe. You can distinguish the universe of one release from 
another by the folder in which it is stored or by its version number 
(see “Determining the Version of the Universe” on page 80).

Tip: You can expand the width of the Universe dialog box to view the 
full path.

Note: Each release of GI2 names the GI2 universe identically: 
GI2_Universe. You can distinguish the universe of one release from 
another by the folder in which it is stored or by its version number 
(see “Determining the Version of the Universe” on page 80).
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Genesys Interactive Insights 8.1 Universe Guide include the name(s) that 
you used in prior releases if they differ from the current release. 

Figure 38: Change Source Dialog Box

6. Save the report and refresh its data. 

7. Repeat these steps for each of the reports that you customized. 

Checking Universe Relationships

To check that none of your custom reports are still associated with the prior 
universe, use the Check Relationships tool that is provided within the BO 
Central Management Console. 

1. From CMC, select Universes, and navigate to the universe from which you 
migrated. 

2. Right-click the GI2 universe (for example, GI2_Universe). From the 
context menu that appears, select Tools > Check Relationships. 

BO displays the object relationships that are associated with the selected 
universe, including the immediate folder that is storing it, all defined 
connections from the universe to the data mart, and any reports that access 
data using universe elements. Figure 39 illustrates a resultant screen that 
shows six reports that are still tied to the universe. If any custom reports 
remain among the listing, migrate them to the newer universe, as 
previously described. 
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Figure 39: Object Relationships to the Universe 
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Chapter

7 Uninstalling Genesys 
Interactive Insights
The setup file that is deployed with Genesys Interactive Insights (GI2) can 
uninstall the application by removing the majority of files that are deployed 
during GI2 installation, and removing the application instance from the 
Microsoft Windows registry. This wizard-driven utility, however, does not 
remove all traces of GI2 from your computer, deleting neither the GI2 universe 
nor the GI2 reports. Additional manual cleanup is required if you wish to 
remove all traces of GI2. 

This chapter guides you through the steps that you must perform to uninstall 
GI2 completely. It contains the following sections: 
 The GI2 Uninstall Routine, page 103 
 Additional Manual Steps to Finish the Uninstall, page 104 
 Uninstalling the Supporting Applications and Data, page 105 

The GI2 Uninstall Routine
You can uninstall GI2 from the setup file that is provided in the installation 
package or by using the Add/Remove Programs utility that is accessed from the 
Windows Control Panel. 

From Installation
Maintenance

1. From the GI2 installation package, double-click the setup.exe file. 

2. From the Welcome page, click Remove. 

From the
Control Panel

1. Select and open Add/Remove Programs. 

2. Select the GI2 application: 
 Genesys Interactive Insights 8.1 

3. Click Add/Remove. 
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This routine deletes all of the deployed files in the GI2 directory and the 
program instance in the Microsoft Windows registry. Any additional files that 
have been placed in this directory after initial deployment, such as the 
generated deploy_unv_rep.log file and any personal files, remain. Next, 
perform the additional steps that are listed in the following section to complete 
the uninstall. 

Additional Manual Steps to Finish 
the Uninstall

After removing the GI2 application, perform each of the following steps to 
complete the uninstallation of GI2:

1. In the directory in which GI2 is installed, delete the installation’s log file 
(gi2_deploy_unv_rep.log). 

2. Delete the GI2 directory. The default location of this directory is: 
 C:\Program Files\GCTI\Genesys Interactive Insights 

3. Open the Central Management Console, and delete the following objects 
from the BO repository: 
 The GI2 universe: 

 GI2_Universe 

This action deletes any custom measures that you might have created 
as well as those that are provided by Genesys. 

 The Interactive Insights folder: 
 Genesys Interactive Insights 

This action deletes all subfolders and any custom reports that you 
might have created and stored within this folder as well as those that 
are provided by Genesys. 

 The Genesys-provided database connection: 
 GI2_GIM_DB 

 The GI2 user groups, if you created these manually. Note that this 
action does not delete the users that are assigned to the groups: 
 Interactive Insights report developers 
 Interactive Insights report editors 
 Interactive Insights report viewers 
 Interactive Insights report basic (8.1.3 and later)
 Interactive Insights access restrictions (8.1.4 and later [and 

8.1.1 releases beginning with 8.1.104])
 The GI2 users, if you created these manually: 

 Developer 
 Editor 
 Viewer 
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 Basic (8.1.102 and later)
 The GI2 access levels, if you created these manually: 

 Interactive Insights report developer access level 
 Interactive Insights report editor access level 
 Interactive Insights report viewer access level
 Interactive Insights report basic access level (8.1.102 and 

later) 

Refer to the SAP BusinessObjects Enterprise Central Management 
Console User’s Guide for information on how to use this application. 

4. (8.1.3 and later) Remove the following job: 
 For 8.1.3: Promotion Management -> Promotions Jobs -> 8.1.3
 For 8.1.4: Promotion Management -> Promotions Jobs -> 8.1.4

5. (Optional) On the computer(s) that was (were) used to import and export 
the universe, in the BO universe directory, delete both of the following: 
 The universe file: 

 GI2_universe.unv 
 The universe folder: 

 GI2_universe 

The default universe directory is in the following location:

C:\Documents and Settings\<user>\Application Data\Business 

Objects\BusinessObjects Enterprise 12.0\Universes 

These manual steps complete the uninstallation of GI2 from your computer. To 
go one step further and uninstall the supporting applications and underlying 
data for GI2, complete the activities that are listed in the next section. 

Uninstalling the Supporting Applications 
and Data

GI2 is powered by the applications that are provided with BO XI suite and the 
data that is stored in your Info Mart: 

• To uninstall BusinessObjects Enterprise, refer to the “Uninstalling 
BusinessObjects Enterprise” chapter in the SAP BusinessObjects 
Enterprise XI 3.1 Installation Guide for Windows (for UNIX). 

• To uninstall the aggregation engine that creates and populates the AG2_* 
tables in Info Mart (AGT_* tables in release 8.1.4 and later, and in 8.1.1 
releases 8.1.104 and later), refer to the “Uninstalling Reporting and 
Analytics Aggregates” chapter in the Reporting and Analytics Aggregates 
8.1 Deployment Guide. 
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Application Files
The Genesys Interactive Insights (GI2) installation routine creates a root folder 
that contains the Business Intelligence Archive Repository (BIAR) of the GI2 
universe and supporting files. If you selected a default location for the 
installation routine to deploy the GI2, the root folder is:

• The C:\Program Files\GCTI\Genesys Interactive Insights directory on 
Windows platforms 

• The directory that you specified (Step 8 on page 62) upon installation on 
UNIX platforms. 

Tables 4 and 5 describe the files and subdirectory that make up the root. Not all 
of these files are deployed for all GI2 8.1 releases. The checkboxes at the top 
right hand corner of each file’s description indicates this information.      

Table 4: Contents of the Root Folder

File Name Description

8.1.0 8.1.1 8.1.3/ 
8.1.4

bo_custom_install.bat 
(Windows) 

bo_custom_install.sh 
(UNIX) 

✓ ✓

When it is executed, script that installs the Genesys-customized version of 
BusinessObjects XI 3.1. 

Notes:
• The GI2 installation routine deploys this file even if you select not to 

install BO. Under such circumstances, to use this script to install BO, 
you must edit the script to specify BO parameters. 

• Because this file contains the unencrypted password to Central 
Management Server (CMS), after installation, consider editing it to 
remove the password, if you are concerned about security. 

gi2.biar.import.jar ✓ ✓

Java application that is called by other deployed scripts and enables the 
import of the GI2 universe, reports, folders, users, user groups, and rights. 
This file is not deployed for GI2 8.1.3 or 8.1.4. 

Note: This application is reserved for internal use and should not be run 
directly. 
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gi2.upgrade.universe.jar ✓ ✓

Java application that renames report measures from a prior release to the 
current release. Refer to the section of the Genesys Interactive Insights 
8.1 User’s Guide that deals with Upgrading GI2 Reports for information 
about this utility. 

Note: This application is reserved for internal use and you should not run 
it directly. 

gi2.utils.jar ✓ ✓

Java application that replaces JSP files that are located in the Tomcat 
directory with Genesys-modified pages, under qualifying circumstances. 

Note: This application is reserved for internal use and should not be run 
directly. 

gi2_customize_bo.bat 
(Windows) 

gi2_customize_bo.sh 
(UNIX)

✓ ✓ ✓

Script that customizes the appearance of BO software with Genesys-
specific images and Java Server Pages (JSP) that encompass the Genesys 
design. 

gi2_deploy_main.bat 
(Windows) 

gi2_deploy_main.sh 
(UNIX)

✓ ✓ ✓

Script that calls the following scripts: 

• gi2_setenv 

• gi2_customize_bo 

• gi2_deploy_unv_rep 

• gi2_deploy_sum 

gi2_deploy_sum.bat 
(Windows) 

gi2_deploy_sum.sh (UNIX) 

✓ ✓

Script that scans the BO repository for deployed GI2 objects and 
compares the scan results with the listing of components that are to be 
installed. (This listing resides within the insights.biar file.) If the scan 
yields no objects that should be installed, this script returns an error. This 
script prepares the environment for the biarImport.jar application and 
relies on BO parameters that are specified in the gi2_setenv script.

gi2_deploy_unv_rep.bat 
(Windows)

gi2_deploy_unv_rep.sh 
(UNIX)

✓ ✓ ✓

For BO XI 3.x users, this script silently imports the GI2 universe, reports, 
documentation, and folders into the BO repository. This script prepares 
the environment for the biarImport.jar application and relies on BO 
parameters that are specified in the gi2_setenv script.

For BI 4.x users, this script calls the SAP Promotion Management Utility 
to deploy the GI2 elements into the BO repository using an .lcm biar file. 

Table 4: Contents of the Root Folder (Continued) 

File Name Description

8.1.0 8.1.1 8.1.3/ 
8.1.4
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gi2_deploy_unv_rep.log 
(Windows & UNIX)

✓ ✓

Log file that contains the results of the GI2 installation. This file is 
generated every time the gi2_deploy_unv_rep script is run. 

gi2_setenv.bat (Windows) 

gi2_setenv.sh (UNIX) 

✓ ✓ ✓

Script that sets BO environment variables for connection to the BO 
repository, based on values that you specified during GI2 installation or 
that you supply manually. Other scripts rely on the contents of this script 
to connect to the BO repository. 

Note: Because this file contains the unencrypted password to CMS, after 
installation, consider editing it to remove the password, if you are 
concerned about security. 

gi2_upgrade_universe.bat 
(Windows) 

gi2_upgrade_universe.sh 
(UNIX) 

✓ ✓

Script that calls the gi2.upgrade.universe utility. 

insights.biar (8.1.0, 8.1.1) 

insights.lcmbiar (8.1.3, 
8.1.4) 

✓ ✓ ✓

BIAR that contains an export of the GI2 universe, reports, PDF 
documents, measure maps, folders, users, groups, and their permissions. 

ip_description.xml ✓ ✓ ✓

File that lists the contents of the installation package. 

read_me.html ✓ ✓ ✓

File that contains general information about the installation package. 

agg ✓ ✓ ✓

Subfolder that contains files that support the Reporting and Analytics 
Aggregates (RAA) component of Genesys Info Mart. Refer to the 
“Application Files” chapter in the Reporting and Analytics Aggregates 8.1 
Deployment Guide for the description of files in this folder. 

com ✓ ✓

Subfolder that contains customization files. 

conf ✓ ✓ ✓

Subfolder that contains configuration files. See Table 5. 

res ✓ ✓ ✓

Subfolder that contains additional customization files, such as JavaServer 
Pages and the Genesys logos that are displayed on the CMC and InfoView 
login screens. 

Table 4: Contents of the Root Folder (Continued) 

File Name Description

8.1.0 8.1.1 8.1.3/ 
8.1.4
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Table 5: Contents of the conf Subfolder

File Name Description

8.1.0 8.1.1 8.1.3/
8.1.4

diff.json ✓ ✓

File that the upgrade utility references to rename report measures. This 
utility is described in chapter of the Genesys Interactive Insights 8.1 
User’s Guide that deals with Upgrading GI2 Reports.

gi2.json ✓ ✓

Configuration file for the biar import utility (see gi2.biar.import.jar 
in Table 4) that checks for existing objects. 

log4j.properties ✓ ✓

Configuration file of logging parameters for the biar import utility. 

biar properties ✓ ✓ ✓

File that is generated during installation when the 
gi2_deploy_unv_rep.bat/sh script is run. 
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Related Documentation 
Resources
The following resources provide additional information that is relevant to this 
software. Consult these additional resources, as necessary. 

SAP BusinessObjects XI 3.1

• The BusinessObjects (BO) documentation set, including the following 
manuals: 
 SAP BusinessObjects Enterprise XI 3.1 Deployment Planning Guide 
 SAP BusinessObjects XI 3.1 Installation Guide for Windows 

(for UNIX), which describes, in detail, how to install BO components 
 SAP BusinessObjects Enterprise XI 3.1 for AIX – Supported Platforms 
 SAP BusinessObjects Enterprise XI 3.1 for HPUX – Supported 

Platforms 
 SAP BusinessObjects Enterprise XI 3.1 for Linux – Supported 

Platforms 
 SAP BusinessObjects Enterprise XI 3.1 for Solaris – Supported 

Platforms 
 SAP BusinessObjects Enterprise XI 3.1 for Windows – Supported 

Platforms 
 SAP BusinessObjects Enterprise XI 3.1 Administrator's Guide 
 SAP BusinessObjects XI 3.1 Server Administration Guide 
 SAP BusinessObjects Central Management Console User's Guide 
 SAP BusinessObjects XI 3.1 Publisher’s Guide 
 SAP BusinessObjects 5/6 to XI 3.1 Migration Guide
 SAP BusinessObjects Enterprise XI 3.1 Upgrade Guide 
 SAP BusinessObjects Enterprise XI 3.1 InfoView User’s Guide 
 SAP BusinessObjects XI 3.1 Building reports with the SAP 

BusinessObjects Web Intelligence HTML Report Panel 
 SAP BusinessObjects Enterprise Building Reports with SAP 

BusinessObjects Web Intelligence Rich Client
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 SAP BusinessObjects XI 3.1 Performing On-Report Analysis with SAP 
BusinessObjects Web Intelligence 

 SAP BusinessObjects XI 3.1 Building Queries with SAP 
BusinessObjects Web Intelligence Query - HTML 

 SAP BusinessObjects XI 3.1 Universe Designer 

The complete set of BO XI documentation is available, for customers who 
obtained BO from Genesys, through the following URL:

http://service.sap.com/sap/bc/bsp/spn/oem_portal/infouser_ 

request.htm?pid=0000279980&code=574DA18E763BA5920D1769FC17946653 

&dstamp=20090604 

It is also available on the separate Genesys Interactive Insights – Platform 
Components – Documentation DVD. 

SAP BusinessObjects Business Intelligence 
Platform 4.1

• Business Intelligence Platform User Guide—SAP BusinessObjects 
Business Intelligence Platform 4.1 Support Package 1

• Business Intelligence Platform User Guide—SAP BusinessObjects 
Business Intelligence Platform 4.1 Support Package 2 

• SAP BusinessObjects BI4 Sizing Companion Guide 

• Business Intelligence Platform Administrator Guide—SAP 
BusinessObjects Business Intelligence Platform 4.1 Support Package 2 

• Business Intelligence Platform Installation Guide for Unix—SAP 
BusinessObjects Business Intelligence Platform 4.1 Support Package 2

• Business Intelligence Platform Installation Guide for Windows—SAP 
BusinessObjects Business Intelligence Platform 4.1 Support Package 2 

• Business Intelligence platform Architecture Diagram 4.1

• SAP BusinessObjects BI 4.1 Supported Platforms 

Genesys Interactive Insights

• Genesys Interactive Insights 8.1 Universe Guide, which describes, in 
detail, the reports and measures that are provided in the Genesys 
Interactive Insights (GI2) release 

• Genesys Interactive Insights 8.1 User’s Guide, which summarizes how to 
operate GI2 reports by using InfoView and provides basic instruction for 
customizing your own reports 

Note: Many documents on this website are available only to direct SAP 
customers.
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• Release Notes and Product Advisories for this product, which are available 
on the Genesys Customer Care website.

Genesys Info Mart

• The Genesys Info Mart 8.1 documentation set, including the following 
manuals: 
 Genesys Info Mart 8.1 Reference Manual for your particular RDBMS 

type, for table and field descriptions of the Info Mart 
 Genesys Info Mart 8.1 Deployment Guide, which will help you 

configure and install Genesys Info Mart 8.1 

Reporting and Analytics Aggregates

• Reporting and Analytics Aggregates 8.1 Deployment Guide, which 
describes how to deploy this option of Genesys Info Mart 

• Reporting and Analytics Aggregates 8.1 Reference Manual, which 
describes the aggregate subject areas, tables, and columns 

• Reporting and Analytics Aggregates 8.1 User’s Guide, which describes 
how the aggregation process works 

Genesys 

• Genesys Technical Publications Glossary, available on the Genesys 
Documentation website, provides a comprehensive list of the Genesys and 
computer-telephony integration (CTI) terminology and acronyms used in 
this document.

• Genesys Migration Guide, available on the Genesys Documentation 
website and which ships on the Genesys Documentation Library DVD, 
provides documented migration strategies for Genesys product releases. 
Contact Genesys Customer Care for more information.

Information about supported hardware and third-party software is available on 
the Genesys Documentation website in the following documents: 

• Genesys Supported Operating Environment Reference Guide

• Genesys Supported Media Interfaces Reference Manual

Consult the following additional resources as necessary:

• Genesys Hardware Sizing Guide, which provides information about 
Genesys hardware sizing guidelines for the Genesys 8.x releases.

For additional system-wide planning tools and information, see the 
release-specific listings of System-Level Documents on the Genesys 
Documentation website (docs.genesys.com).

http://www.genesys.com/customer-care
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/Documentation/System
http://docs.genesys.com/MoreDocs/Genesys_Supported_Operating_Environment_Reference_Guide
http://docs.genesys.com/wiki/index.php/Special:Repository/g_ref_smi.pdf?id=73c96eb2-c7cb-4839-95e5-0c910861e615
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Genesys product documentation is available on the:

• Genesys Customer Care website at http://genesys.com/customer-care.

• Genesys Documentation site at http://docs.genesys.com/.

• Genesys Documentation Library DVD, which you can order by e-mail 
from Genesys Order Management at orderman@genesys.com.

http://genesys.com/customer-care
http://docs.genesys.com/
mailto:orderman@genesys.com
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Document Conventions

Document Conventions
This document uses certain stylistic and typographical conventions— 
introduced here—that serve as shorthands for particular kinds of information.

Document Version Number

A version number appears at the bottom of the inside front cover of this 
document. Version numbers change as new information is added to this 
document. The following is a sample version number:

81ii_dep_05-2013_v8.1.300.02 

You will need this number when you are talking with Genesys Customer Care 
about this product.

Screen Captures Used in This Document

Screen captures from the product graphical user interface (GUI), as used in this 
document, may sometimes contain minor spelling, capitalization, or 
grammatical errors. The text that accompanies and explains the screen captures 
corrects such errors except when such a correction would prevent you from 
installing, configuring, or successfully using the product. For example, if the 
name of an option contains a usage error, the name would be presented exactly 
as it appears in the product GUI; the error would not be corrected in any 
accompanying text.

Type Styles

Table 7 describes and illustrates the type conventions that are used in this 
document.

Table 7: Type Styles

Type Style Used For Examples

Italic • Document titles

• Emphasis

• Definitions of (or first references to) 
unfamiliar terms

• Mathematical variables

Used also to indicate placeholder text within 
code samples or commands, in the special case 
in which angle brackets are a required part of 
the syntax (see the note about angle brackets 
on page 116).

Please consult the Genesys Migration 
Guide for more information.

Do not use this value for this option.

A customary and usual practice is one 
that is widely accepted and used within a 
particular industry or profession.

The formula x +1 = 7, 
where x stands for . . .
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Monospace 
font

(Looks like 
teletype or 
typewriter 
text)

All programming identifiers and GUI 
elements. This convention includes:

• The names of directories, files, folders, 
configuration objects, paths, scripts, dialog 
boxes, options, fields, text and list boxes, 
operational modes, all buttons (including 
radio buttons), check boxes, commands, 
tabs, CTI events, and error messages.

• The values of options.

• Logical arguments and command syntax.

• Code samples.

Used also for any text that users must manually 
enter during a configuration or installation 
procedure, or on a command line.

Select the Show variables on screen 
check box.

In the Operand text box, enter your 
formula.

Click OK to exit the Properties dialog 
box.

T-Server distributes the error messages in 
EventError events.

If you select true for the 
inbound-bsns-calls option, all 
established inbound calls on a local agent 
are considered business calls.

Enter exit on the command line.

Square 
brackets ([ ])

A particular parameter or value that is optional 
within a logical argument, a command, or 
some programming syntax. That is, the 
presence of the parameter or value is not 
required to resolve the argument, command, or 
block of code. The user decides whether to 
include this optional information.

smcp_server -host [/flags]

Angle 
brackets 
(< >)

A placeholder for a value that the user must 
specify. This might be a DN or a port number 
that is specific to your enterprise.

Note: In some cases, angle brackets are 
required characters in code syntax (for 
example, in XML schemas). In these cases, 
italic text is used for placeholder values.

smcp_server -host <confighost>

Table 7: Type Styles (Continued) 

Type Style Used For Examples
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